Getting Started
This is a blank page
Contents

Where to Start........................................................................................................................................... 1
Before Installation ................................................................................................................................. 2
Starting AutoCAD Mechanical 2000 ........................................................................................................ 2
Where to Go First .................................................................................................................................. 2
  New AutoCAD User.......................................................................................................................... 2
  New AutoCAD Mechanical 2000 User.......................................................................................... 3
  Upgrading User............................................................................................................................... 3
Migrating Genius 14 Files..................................................................................................................... 4
AutoCAD Mechanical 2000 Documentation ....................................................................................... 4
  Printed Manuals................................................................................................................................. 4
  Online Documentation.................................................................................................................... 5
  AutoCAD Documentation................................................................................................................. 5
How to Use Help.................................................................................................................................. 6
  Accessing Help ................................................................................................................................. 6
  Finding Information in Help........................................................................................................... 6
Internet Resources............................................................................................................................... 10
How to Reach Us................................................................................................................................ 10

If you are New to AutoCAD Mechanical .......................................................................................... 11
About AutoCAD Mechanical 2000........................................................................................................ 12
  Functionality Overview................................................................................................................... 12
  Command Summary........................................................................................................................ 15
  AutoCAD Mechanical 2000 - Configuration Examples.................................................................. 22
About AutoCAD Mechanical 2000 Power Pack................................................................................ 26
  Functionality Overview................................................................................................................... 26
  Command Summary........................................................................................................................ 28
  AutoCAD Mechanical 2000 Power Pack - Configuration Examples........................................... 31
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experienced with Genius</td>
<td>33</td>
</tr>
<tr>
<td>General Changes</td>
<td>34</td>
</tr>
<tr>
<td>Working with Previous Versions of Genius</td>
<td>34</td>
</tr>
<tr>
<td>Issuing Commands</td>
<td>34</td>
</tr>
<tr>
<td>Menu and Toolbar Changes</td>
<td>35</td>
</tr>
<tr>
<td>Full Support of Templates</td>
<td>35</td>
</tr>
<tr>
<td>Remove of Redefined Commands</td>
<td>35</td>
</tr>
<tr>
<td>Network Installation Capability for Standard Parts</td>
<td>35</td>
</tr>
<tr>
<td>Migrating Genius Drawings to AutoCAD Mechanical 2000</td>
<td>36</td>
</tr>
<tr>
<td>Migrating Layers and Drawing Settings</td>
<td>38</td>
</tr>
<tr>
<td>Using the AMMIGRATEBB Command</td>
<td>40</td>
</tr>
<tr>
<td>More Information About Migrating Parts List Information</td>
<td>56</td>
</tr>
<tr>
<td>Migrating Symbols</td>
<td>59</td>
</tr>
<tr>
<td>Purging After Migration</td>
<td>61</td>
</tr>
<tr>
<td>Migrating Standard Parts</td>
<td>62</td>
</tr>
<tr>
<td>Migrating Blocks</td>
<td>62</td>
</tr>
<tr>
<td>Using the Script Generator for One-Step Migration</td>
<td>63</td>
</tr>
<tr>
<td>Revised Commands</td>
<td>67</td>
</tr>
<tr>
<td>AMCONFIG</td>
<td>67</td>
</tr>
<tr>
<td>AMLAY</td>
<td>76</td>
</tr>
<tr>
<td>AMLIBRARY</td>
<td>77</td>
</tr>
<tr>
<td>AMOBJPURGE</td>
<td>78</td>
</tr>
<tr>
<td>AMSCMONITOR</td>
<td>80</td>
</tr>
<tr>
<td>AMPowersnap</td>
<td>80</td>
</tr>
<tr>
<td>AMBOM</td>
<td>83</td>
</tr>
<tr>
<td>AMBALLOON</td>
<td>85</td>
</tr>
<tr>
<td>AMDATUMID</td>
<td>86</td>
</tr>
<tr>
<td>AMDATUMTGT</td>
<td>87</td>
</tr>
<tr>
<td>AMFCFRAME</td>
<td>89</td>
</tr>
<tr>
<td>AMSURFSYM</td>
<td>91</td>
</tr>
<tr>
<td>AMSYMLEADER</td>
<td>92</td>
</tr>
<tr>
<td>AMSYMSTD</td>
<td>93</td>
</tr>
<tr>
<td>AMWELDSYM</td>
<td>99</td>
</tr>
<tr>
<td>Experienced with AutoCAD Mechanical 14.x</td>
<td>101</td>
</tr>
<tr>
<td>General Changes</td>
<td>102</td>
</tr>
<tr>
<td>Integrated Genius Functionality</td>
<td>102</td>
</tr>
<tr>
<td>Issuing Commands</td>
<td>103</td>
</tr>
<tr>
<td>Menu and Toolbar Changes</td>
<td>103</td>
</tr>
<tr>
<td>Migrating AutoCAD Mechanical 14 Drawings</td>
<td>103</td>
</tr>
<tr>
<td>New and Revised Commands</td>
<td>104</td>
</tr>
<tr>
<td>Toolbar Icons</td>
<td>105</td>
</tr>
</tbody>
</table>
Main Toolbar .....................................................................................................106
  Main Toolbar ➔ New ..........................................................................................106
  Main Toolbar ➔ Basic Layer .............................................................................106
  Main Toolbar ➔ EX Layer Functions .................................................................107
  Main Toolbar ➔ Inquiry .................................................................................107
  Main Toolbar ➔ Undo ........................................................................................107
  Main Toolbar ➔ Library ....................................................................................107
  Main Toolbar ➔ Power Edit ...............................................................................108
  Main Toolbar ➔ Power Erase ............................................................................108
  Main Toolbar ➔ Power Dimensioning ..............................................................108
  Main Toolbar ➔ Power Dimensioning ➔ Units ...............................................108
  Main Toolbar ➔ Power Snap ...........................................................................109
  Main Toolbar ➔ Compass Rose .......................................................................109
  Main Toolbar ➔ UCS .......................................................................................109
Zoom Toolbar .....................................................................................................110
  Zoom Toolbar ➔ Zoom .....................................................................................110
  Zoom Toolbar ➔ Zoom 2 ................................................................................110
Design Toolbar ...................................................................................................110
  Design Toolbar ➔ Draw ....................................................................................111
  Design Toolbar ➔ Draw ➔ Line .........................................................................111
  Design Toolbar ➔ Draw ➔ EX Arc .....................................................................111
  Design Toolbar ➔ Draw ➔ EX Rectangle ..........................................................112
  Design Toolbar ➔ Draw ➔ Circle .....................................................................112
  Design Toolbar ➔ Draw ➔ EX Centerlines ......................................................113
  Design Toolbar ➔ Draw ➔ Hatch .....................................................................113
  Design Toolbar ➔ Draw ➔ EX Construction Line ...........................................114
  Design Toolbar ➔ Draw ➔ EX Construction Edit ...........................................114
  Design Toolbar ➔ Modify ................................................................................115
  Design Toolbar ➔ Modify ➔ Copy ......................................................................115
  Design Toolbar ➔ Modify ➔ 2D Operations .....................................................115
  Design Toolbar ➔ Modify ➔ Break ....................................................................115
  Design Toolbar ➔ Modify ➔ Divide ...................................................................115
  Design Toolbar ➔ Modify ➔ Stretch .................................................................115
  Design Toolbar ➔ 2D Hide ...............................................................................116
  Design Toolbar ➔ XREF ..................................................................................116
Assistance Toolbar .............................................................................................116
  Assistance Toolbar ➔ Block Create .................................................................116
  Assistance Toolbar ➔ XREF Block Insert .......................................................117
  Assistance Toolbar ➔ Title Block .....................................................................117
  Assistance Toolbar ➔ Text ..............................................................................117
  Assistance ➔ Modelspace/Layout ....................................................................117
Annotation Toolbar ............................................................................................118
  Annotation Toolbar ➔ Symbols ........................................................................118
  Annotation Toolbar ➔ Leader ..........................................................................118
  Annotation Toolbar ➔ BOM .............................................................................118
Content Toolbar ........................................................................................................... 118
- User Holes .............................................................................................................. 119
- Standard Tools ...................................................................................................... 119
- Cam Plates ........................................................................................................... 119
- Calculations ........................................................................................................ 119

Power Snap Toolbar ................................................................................................. 120
- Point Filters ......................................................................................................... 120

Power Pack Content Toolbar ..................................................................................... 121
- Screw Connection ................................................................................................. 121
- Holes .................................................................................................................... 121
- Shaft Generator .................................................................................................... 121
- Standard Tools .................................................................................................... 122
- Standard Parts ..................................................................................................... 122
- PP Calculation ..................................................................................................... 122
- Cam Plates ........................................................................................................... 122
- Chain / Belt Calculations ..................................................................................... 123

Accelerator Keys ......................................................................................................... 125
Using Accelerator Keys ............................................................................................. 126

Tablet Commands ..................................................................................................... 131
Using Tablet Commands .......................................................................................... 132
- Tablet Area 1 ....................................................................................................... 132
- Tablet Area 2 ....................................................................................................... 140
- Tablet Area 3 ....................................................................................................... 144
- Tablet Area 4 ....................................................................................................... 145

Glossary ....................................................................................................................... 149
Where to Start

*Getting Started* provides an overview of the AutoCAD Mechanical 2000 functions and mechanical design concepts. It guides you to the information you need to make AutoCAD Mechanical 2000 work for you, regardless of your mechanical design experience. You can quickly learn about new and revised features, working environments, user interface, and using the online Help. You can also find information about toolbar icons, accelerator keys, tablet commands, and a glossary of terms.

- Before Installation
- Starting AutoCAD Mechanical 2000
- Where to go first
- Migrating Genius13/14 files
- AutoCAD Mechanical 2000 documentation
- Help in AutoCAD Mechanical 2000
- Internet resources
- How to reach us
Before Installation

Whether you are new to AutoCAD or AutoCAD Mechanical 2000, or you are upgrading from a previous release of AutoCAD, you need to read the following important information before you install the software:

- The *Autodesk Mechanical Products Installation Guide* includes system requirements and procedures for installing AutoCAD Mechanical 2000 software in a single-user or network environment.
- *Readme* contains important last-minute information that is not included in the print and online documentation.

Starting AutoCAD Mechanical 2000

You can start AutoCAD Mechanical 2000 by using one of the following procedures:

- On the taskbar, click Start, then choose Programs. Choose AutoCAD Mechanical 2000.
- On the desktop, double-click the AutoCAD Mechanical 2000 icon.

Where to Go First

Here you learn what components of the documentation are most helpful for your level of experience. In the section “AutoCAD Mechanical 2000 Documentation”, the print and online documentation components and their locations are described.

New AutoCAD User

If you are new to AutoCAD

- Start by viewing the AutoCAD Quick Tour. This is an overview of AutoCAD and the concepts of computerized drafting. From the Help menu, select AutoCAD, AutoCAD Quick Tour.
- Go through the lessons in the online AutoCAD Tutorials. From the Help menu, choose AutoCAD, Tutorials.

Use the AutoCAD Learning Assistance, a multimedia learning tool that focuses on understanding difficult concepts. The Learning Assistance CD-ROM is included in your software package.

Once you are familiar with AutoCAD, follow the suggestions in the next section for learning AutoCAD Mechanical 2000.

**New AutoCAD Mechanical 2000 User**

If you are familiar with AutoCAD, but you are new to AutoCAD Mechanical 2000

- Read Chapter 2, “If you are New to AutoCAD Mechanical”. This is an overview of AutoCAD Mechanical basics, the user interface.
- Go through the *AutoCAD Mechanical 2000 Tutorials* manual. The tutorials are also offered in PDF format in the Help and on CD. Choose AutoCAD Mechanical 2000, Mastering AutoCAD Mechanical 2000.
- Refer to the glossary on page 149 to familiarize yourself with AutoCAD Mechanical terminology.
- As you use AutoCAD Mechanical, refer to Help for information about commands, procedures, and concepts. From the Help menu, choose AutoCAD Mechanical 2000, choose the general area of information you seek, and then choose a specific topic.

**Upgrading User**

If you are upgrading from a previous release of AutoCAD Mechanical

- See the online “What’s New in AutoCAD Mechanical” for the concepts, procedures, and related commands for all of the new features in this release. From the Help menu, select AutoCAD Mechanical 2000, then What’s New in AutoCAD Mechanical 2000.
**Migrating Genius 14 Files**

To migrate Genius 14 parts lists and symbols to use with AutoCAD Mechanical 2000, you can use the AMMIGRATEBB and AMMIGRATESYM commands. See chapter 3 for information and procedures for using these commands.

**AutoCAD Mechanical 2000 Documentation**

Your AutoCAD Mechanical 2000 purchase includes an extensive set of printed and online documentation.

**Printed Manuals**

In addition to this *Getting Started*, the AutoCAD Mechanical 2000 printed documentation includes:

- *Autodesk Mechanical Products Installation Guide* combines information for AutoCAD Mechanical 2000 single-user and network environments, and includes system requirements, installation procedures, and uninstalling the software.
- *AutoCAD Mechanical 2000 Tutorials* provides basic to advanced lessons for learning both the program and mechanical design concepts. The lessons have been updated with instructions for using some of the new features. There are also new tutorials to help first-time users become productive more quickly. Tutorials 9 to 14 cover with AutoCAD Mechanical 2000 Power Pack functions and can be worked through only if you have installed the Power Pack package.

To obtain a printed copy of the *AutoCAD Command Reference* or the *AutoCAD Customization Guide*, contact your AutoCAD dealer. The *AutoCAD Mechanical 2000 Command Reference* is available online in Help and in PDF format on the AutoCAD Mechanical 2000 Web site.
Online Documentation

You can access online documentation by selecting AutoCAD Mechanical 2000 from the Help menu. Other methods for getting Help are described in “Accessing Help” on page 6. In Help, choose from the following general areas of information, then choose your specific topic.

- “What’s New in AutoCAD Mechanical 2000,” contains concepts, procedures and related commands for the new features in this release.
- “Mastering AutoCAD Mechanical,” links to a complete set of step-by-step tutorials in PDF format. With Adobe Acrobat reader, you can view and print the tutorials exactly as they appear in the printed Tutorials manual.
- “Guide to Pages” is the doorway to Help topics. Select what you want to work with, then select your specific topic to get a guide page for that topic. The guide page contains conceptual information, links to procedures and commands, and all other information pertinent to that topic.
- “Command Reference” contains information about all the commands.
- “AutoCAD” is the doorway for all of the AutoCAD online documentation, which is separate from AutoCAD Mechanical online documentation.
- Autodesk IGES Translator
- “Using Help” contains instructions on how to use the AutoCAD Mechanical 2000 help system.
- “AutoCAD Mechanical 2000 and AutoCAD Documentation Updates” downloads updated Help files from the Autodesk Web site if you have access to the Internet. A link to this site is accessible from “Where to Start” in the AutoCAD Mechanical 2000 Help topics.

AutoCAD Documentation

The complete set of AutoCAD Documentation is available in Help, including the AutoCAD Installation Guide, AutoCAD Tutorials, AutoCAD Command Reference, AutoCAD Customization Guide, and AutoCAD ActiveX Automation. The AutoCAD Learning Assistance CD-ROM that is included in your package is a multimedia learning tool for intermediate to experienced users.
How to Use Help

The Help system for AutoCAD Mechanical 2000 follows the conventions of Windows 98 help. Help contains information about the features in AutoCAD Mechanical. It is one component of the AutoCAD Mechanical 2000 documentation set. It does not replace the printed Autodesk Mechanical Products Installation Guide, Getting Started, or Tutorials manuals. Rather, it is a source of specific information about the features of the program that both beginners and experienced users can use.

Accessing Help

To access Help, do one of the following:

- From the Help menu, select AutoCAD Mechanical 2000 Help Topics.
- Click F1. This opens the topic for an active button or command.
- Select the Help button in the standard toolbar.
- Click the ? button in the title bar of most dialog boxes. This opens the topic for that dialog.
- If a dialog boxes does not contain a ? button, look for a Help button.
- Highlight a command in the menu and press the F1.

Finding Information in Help

Choosing AutoCAD Mechanical Help Topics from the Help menu opens the Help Topics dialog for AutoCAD Mechanical.

There are three navigation and search methods to help you find the information you want: Contents, Index, and Find—which you can use to locate a topic.
Using the Contents Tab

Click the Contents tab to browse through topics by category.

The Contents tab contains topics arranged in books. Double-click a book icon to open it. In addition to AutoCAD and IGES help topics, the Contents tab contains the following books:

Where to Start

What’s New in AutoCAD Mechanical
Mastering the AutoCAD Mechanical
Guide to Pages - AutoCAD Mechanical
Command References - AutoCAD Mechanical, AutoCAD
Tutorials – AutoCAD

Where to Start

This is an overview of the AutoCAD Mechanical documentation set. It includes a link to Adobe Acrobat PDF files of the printed Tutorials manual. If you have Internet access, you can also jump to the AutoCAD Mechanical web site and download updated Help files for AutoCAD Mechanical and AutoCAD.

What’s New in AutoCAD Mechanical

This book contains information on new features. Double-click a topic to open a What’s New window for that topic. The window contains a brief description of the feature, a list of procedures, and a list of any associated commands.
From here you can jump to a key concept, or overview, of the feature, to a specific procedure, or to related commands.

Guide to Pages

This book contains lists of step-by-step procedures for the most commonly used AutoCAD Mechanical and AutoCAD tasks. Double-click a procedure from the list to open the Guide to... window. For Mechanical Desktop topics, you can link to key concepts that give you an overview of the feature.
Command References

This book contains individual command references on commands and system variables for AutoCAD Mechanical and AutoCAD.

Mastering AutoCAD Mechanical and Tutorials

This includes tutorials for both AutoCAD Mechanical (same contents as the printed Tutorials manual, but in PDF format), and AutoCAD.

Using Help

If you need assistance using the Help system while you’re working with the software, look at the topics included in this category.

AutoCAD Documentation


Using the Index Tab

Click the Index Tab to see a list of index entries. Either enter the word you’re looking for, or scroll through the list.
Using the Find Tab

Click the Find tab to search for words or phrases that may be contained in a Help topic. The first time you use the Find Tab, it generates a list of all words in the Help system. This takes a few minutes, but you only have to do this once. Then, when you enter the words you want to search for, AutoCAD Mechanical gives you a list of all topics containing those words.

Internet Resources

The following are Internet resources for information about Autodesk products and assistance with your questions.

- Autodesk web site: http://www.autodesk.com
- Autodesk Mechanical Design web site: http://www.autodesk.com/solution/mech/index.htm

How to Reach Us

Use the following email addresses and telephone numbers to reach us.

- Documentation suggestions, errors, or questions: Send email to mcad_docs@autodesk.com (for AutoCAD Mechanical 2000), and acad_docs@autodesk.com (for AutoCAD).
- Autodesk Fax Information System: (415) 446-1919
- Autodesk Official Training Courseware (AOTC): Contact an Autodesk Authorized Training Center or Dealer to inquire about AutoCAD Mechanical 2000 training using AOTC, the Autodesk-endorsed courseware for instructor-led training.
If you are New to AutoCAD Mechanical

This chapter contains helpful information about AutoCAD Mechanical if you have not used AutoCAD Mechanical or Genius before.

This chapter has two sections. The first section covers the basics of AutoCAD Mechanical 2000, while the second section covers the basics of the AutoCAD Mechanical 2000 Power Pack.

- About AutoCAD Mechanical 2000
- AutoCAD Mechanical 2000 Configuration Examples
- About AutoCAD Mechanical 2000 Power Pack
- AutoCAD Mechanical 2000 Power Pack Configuration Examples
About AutoCAD Mechanical 2000

Functionality Overview

AutoCAD Mechanical 2000 is AutoCAD 2000 optimized for mechanical design and engineering. AutoCAD Mechanical 2000 includes all of the functionality of AutoCAD 2000 plus key new functionality in four areas of mechanical design. An overview of these four areas, and examples of some of the functionality found in each, is listed below.

Design Productivity

Features designed to make you more productive and reduce the number of steps needed to complete your mechanical designs include:

- An intelligent, customizable layer management system that puts objects on the appropriate layers automatically.
- Power commands which provide a single command to edit, copy (with the objects intelligence), update, or recall a previous command.
- Double-click editing – where you can double-click any entity in AutoCAD Mechanical 2000 and the appropriate function needed to edit that entity is invoked.
- Simple commands for creating geometry typically found in mechanical drawings such as centerlines and center crosses, construction lines, symmetrical lines, section lines, break lines, and others.
Production Drawing Creation Tools

There's more to creating a production-ready drawing than just completing the design. AutoCAD Mechanical 2000 offers tools that automate the creation of objects typically found on drawings and reduces the time you need to complete your production drawing. Features include:

- **Balloons and bills of material** including support of multiple parts lists per drawing as well as features such as summation and position lists and mask editor.
- A feature for creating detailed views at user-specified scale and location.
- Functionality for creating standard sized drawing borders and title blocks in your drawing.
- A command for creating hole charts and charts of ordinate (X,Y) coordinates.
- **Language conversion** features for converting the text on a drawing into one of 17 different languages.

Dimensioning and Annotation Productivity

Features designed to make you more productive dimensioning and annotating your mechanical designs include:

- **Power Dimension** provides a single command to create or edit any type of linear, radial, or diameter dimension including adding fits or tolerances.
- An automatic dimension command adds either ordinate or baseline dimensions to 2D geometry automatically.
- A feature for quick creation of hole notes.
- Functionality for creating surface texture symbols, geometric dimensioning and tolerances, targets, weld symbols, and other symbols commonly found on mechanical drawings.
2D Assembly Design Tools

Functionality aimed at helping you manage detailed component drawings from a 2D assembly include:

- A 2D Hide command for performing 2D hidden line calculations based on foreground and background objects.
- Auto Detailing functionality for creating and managing detailed drawings of individual components from an assembly drawing.
- Enhancements to the AutoCAD 2000 XREF Manager and Block Editor for manipulating the representation of xrefs as well as the representation of hidden lines and dimension lines within xrefs and blocks.

Calculation Tools

AutoCAD Mechanical 2000 provides the following tools for saving you time with your engineering calculations and insuring you get the design right the first time:

- Cam Generator creates cam plates and cylindrical cams given input border conditions. Velocity and acceleration, as well as the cam curve path can be calculated and displayed. Driven elements can be coupled to the cam and NC data can be created via the curve on the path.
- Beam Calculations determines the moment of inertia and deflection of beams.

There’s More …

We’ve only covered an overview of what’s available in AutoCAD Mechanical 2000. Included are many more productivity enhancing features and functions so be sure to read the next section for a command summary listing of all of the AutoCAD Mechanical 2000 features.
**Command Summary**

Following is a list of the AutoCAD Mechanical 2000 commands and a brief description of each. For a detailed description of each command, see the online Help. This list does not include the commands for AutoCAD 2000. See the online Help for information about those commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AM2DHIDE</td>
<td>Performs hidden line operations on 2 or more components in a 2D assembly.</td>
</tr>
<tr>
<td>AM2DHIDEDIT</td>
<td>Allows editing of the invisible/hidden edges of a 2D hide.</td>
</tr>
<tr>
<td>AMANALYSEDWG</td>
<td>Analyzes the current drawing file and to obtain information about the type of layers, lines, line weights, and colors used in the drawing.</td>
</tr>
<tr>
<td>AMASSOHATCH</td>
<td>Moves an existing hatch to a changed contour.</td>
</tr>
<tr>
<td>AMAUTOCLINES</td>
<td>Draws predefined construction lines on a selected drawing element.</td>
</tr>
<tr>
<td>AMAUTODETAIL</td>
<td>Creates an external detail drawing of selected elements from an assembly drawing.</td>
</tr>
<tr>
<td>AMAUTODIM</td>
<td>Automatically creates ordinate, baseline, and/or shaft dimensioning and allows the style of previously created automatic dimensions to be changed.</td>
</tr>
<tr>
<td>AMAUTODIM_ANG</td>
<td>Creates angular dimensions.</td>
</tr>
<tr>
<td>AMBALLOON</td>
<td>Places balloon call-outs for components in an assembly.</td>
</tr>
<tr>
<td>AMBOM</td>
<td>Includes part attributes and values in the BOM database.</td>
</tr>
<tr>
<td>AMBREAKATPT</td>
<td>Breaks a line, polyline, or spline at a selected point.</td>
</tr>
<tr>
<td>AMBROUTLINE</td>
<td>Creates a break-out line.</td>
</tr>
<tr>
<td>AMCAM</td>
<td>Opens the Cam dialog box for creating cams. Includes links to the dialog boxes of the individual cam commands listed below.</td>
</tr>
<tr>
<td>AMCAMCONF</td>
<td>Configures for the cam function.</td>
</tr>
</tbody>
</table>
AMCAMCRCAM Generates a cam from a graph.
AMCAMCRGRAPH Generates a graph from a cam.
AMCAMGRAPH Calculates velocity and acceleration graphs for a cam.
AMCAMNC Generates a NC data file from an existing cam.
AMCAMTRANS Creates movement sections for the cam calculation.
AMCENCRCORNER Inserts a hole (circle), with appropriate centerlines, at given offset distance from two edges.
AMCENCRCFULLCIRCLE Draws a given number of holes (circles), with appropriate centerlines, about given diameters.
AMCENCRCRHOELE Inserts a hole (circle), with appropriate centerlines, at the picked point.
AMCENCRRHOLE Draws centerlines in the selected holes.
AMCENCROSS Draws two orthogonal centerlines at the picked point.
AMCENCRRPLATE Inserts a hole (circle), with appropriate centerlines, at given offset distance from every corner in a selected contour.
AMCENRINBET Draws a centerline between two selected lines.
AMCENTLINE Draws a centerline at the picked points.
AMCHAM2D Creates a chamfer.
AMCHGTSC Changes the scale of the drawing border and title block.
AMCINEL Locks or unlocks the construction line layer.
AMCINEO Freezes or thaws the construction line layer.
AMCONFIG Displays the AutoCAD Mechanical configuration dialog.
AMCONSTLINES Main dialog box for drawing construction lines.
AMCONSTSWI Switches from Xlines to Xray and vice versa.
<table>
<thead>
<tr>
<th>Command Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMCONTIN</td>
<td>Locates and traces the inner contour of a group of objects.</td>
</tr>
<tr>
<td>AMCONTOU7</td>
<td>Locates and traces the outer contour of a group of objects.</td>
</tr>
<tr>
<td>AMCONTRACE</td>
<td>Traces the inner or outer contour of selected geometry.</td>
</tr>
<tr>
<td>AMCONVVDWG</td>
<td>Converts the current drawing file from one drawing file format to another drawing file format.</td>
</tr>
<tr>
<td>AMCOPYM</td>
<td>Makes multiple copies of a selection.</td>
</tr>
<tr>
<td>AMCOPYRM</td>
<td>Copies, rotates, or moves selected objects.</td>
</tr>
<tr>
<td>AMCUTPLNLJNE</td>
<td>Creates a section line and identifiers.</td>
</tr>
<tr>
<td>AMDATUMID</td>
<td>Creates a datum identifier symbol.</td>
</tr>
<tr>
<td>AMDATUMTGT</td>
<td>Creates a datum target symbol.</td>
</tr>
<tr>
<td>AMDEFLINE</td>
<td>Creates a deflection line based on a beam calculation.</td>
</tr>
<tr>
<td>AMDETAIL</td>
<td>Creates a detail view of a portion of the design.</td>
</tr>
<tr>
<td>AMDIMALIGN</td>
<td>Aligns dimensions to another selected dimension.</td>
</tr>
<tr>
<td>AMDIMARRANGE</td>
<td>Arranges selected dimensions at the proper offset distance from a selected edge.</td>
</tr>
<tr>
<td>AMDIMBREAK</td>
<td>Creates a break in a dimension line.</td>
</tr>
<tr>
<td>AMDIMINSERT</td>
<td>Inserts a dimension between other dimensions.</td>
</tr>
<tr>
<td>AMDIMJOIN</td>
<td>Joins two or more dimensions into one.</td>
</tr>
<tr>
<td>AMDIMEDIT</td>
<td>Edits the selected dimensions.</td>
</tr>
<tr>
<td>AMDIMSTRETCH</td>
<td>Stretches geometry to the entered dimension value.</td>
</tr>
<tr>
<td>AMEDGESYM</td>
<td>Creates edge symbols.</td>
</tr>
<tr>
<td>AMEQUATEDIT</td>
<td>Generates and organizes equations.</td>
</tr>
<tr>
<td>AMERASEALLCL</td>
<td>Erases all construction lines.</td>
</tr>
<tr>
<td>AMERASECL</td>
<td>Erases all construction lines in a given window.</td>
</tr>
<tr>
<td>AMFCFRAME</td>
<td>Creates a feature control frame.</td>
</tr>
<tr>
<td>AMFEATID</td>
<td>Creates a feature identifier.</td>
</tr>
<tr>
<td>AMFILLET2D</td>
<td>Creates a fillet.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AMFITSLIST</td>
<td>Inserts a fit list from a placed dimension.</td>
</tr>
<tr>
<td>AMHATCH_135_11</td>
<td>Creates a 135 degree and 11 mm/0.4 inch hatch.</td>
</tr>
<tr>
<td>AMHATCH_135_2</td>
<td>Creates a 135 degree and 2.7 mm/0.12 inch hatch.</td>
</tr>
<tr>
<td>AMHATCH_135_4</td>
<td>Creates a 135 degree and 4.7 mm/0.19 inch hatch.</td>
</tr>
<tr>
<td>AMHATCH_45_13</td>
<td>Creates a 45 degree and 13 mm/0.5 inch hatch.</td>
</tr>
<tr>
<td>AMHATCH_45_2</td>
<td>Creates a 45 degree and 2.5 mm/0.1 inch hatch.</td>
</tr>
<tr>
<td>AMHATCH_45_5</td>
<td>Creates a 45 degree and 5 mm/0.22 inch hatch.</td>
</tr>
<tr>
<td>AMHELP</td>
<td>Displays the help file for the current program.</td>
</tr>
<tr>
<td>AMHOLECHART</td>
<td>Creates hole charts.</td>
</tr>
<tr>
<td>AMINERTIA</td>
<td>Calculate the moment of inertia.</td>
</tr>
<tr>
<td>AMINERTIAPROF</td>
<td>Defines a profile section for moment of inertia and deflection line calculations.</td>
</tr>
<tr>
<td>AMJOIN</td>
<td>Joins entities.</td>
</tr>
<tr>
<td>AMLANGCONV</td>
<td>Translates text strings in the drawing into another language.</td>
</tr>
<tr>
<td>AMLANGTEXT</td>
<td>Text library used by the Language Converter.</td>
</tr>
<tr>
<td>AMLAY</td>
<td>Manages the layer system.</td>
</tr>
<tr>
<td>AMLAYINVO</td>
<td>Switches the invisible lines on or off.</td>
</tr>
<tr>
<td>AMLAYMOVE</td>
<td>Moves entities to another layer.</td>
</tr>
<tr>
<td>AMLAYMOVEPL</td>
<td>Moves entities to parts layers.</td>
</tr>
<tr>
<td>AMLAYMOVEWL</td>
<td>Moves entities to working layers.</td>
</tr>
<tr>
<td>AMLAYPARTO</td>
<td>Thaws or freezes parts layers.</td>
</tr>
<tr>
<td>AMLAYPARTREFO</td>
<td>Switches part reference layers on or off.</td>
</tr>
<tr>
<td>AMLAYRESET</td>
<td>Sets all layers back.</td>
</tr>
<tr>
<td>AMLAYTIBLO</td>
<td>Switches the border and title block layer on/off.</td>
</tr>
<tr>
<td>AMLAYVISENH</td>
<td>Temporarily switches the color of all non-current layer groups to a user-defined color.</td>
</tr>
<tr>
<td>AMLAYVPO</td>
<td>Switches the viewport layer on or off.</td>
</tr>
<tr>
<td>AMLG</td>
<td>Controls the layer and layer group control.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AMLGMOVE</td>
<td>Moves lines or blocks to another layer group.</td>
</tr>
<tr>
<td>AMLIBRARY</td>
<td>Library for managing designs and drawings.</td>
</tr>
<tr>
<td>AMNOTE</td>
<td>Creates hole notes.</td>
</tr>
<tr>
<td>AMOBJPROP</td>
<td>Shows the properties of the selected object.</td>
</tr>
<tr>
<td>AMOBJPURGE</td>
<td>Clears the drawing of unreferenced symbols.</td>
</tr>
<tr>
<td>AMOFFSET</td>
<td>Offsets selected geometry.</td>
</tr>
<tr>
<td>AMPARTLIST</td>
<td>Creates parts lists from items in the BOM database.</td>
</tr>
<tr>
<td>AMPARTREF</td>
<td>Creates part reference information to populate the BOM database.</td>
</tr>
<tr>
<td>AMPARTREFEDIT</td>
<td>Edits part reference information.</td>
</tr>
<tr>
<td>AMPLODTDATE</td>
<td>Inserts the current date in the lower right corner of the title block.</td>
</tr>
<tr>
<td>AMPOWERCOPY</td>
<td>Copies an object with its internal information to another position in the drawing.</td>
</tr>
<tr>
<td>AMPOWERDIM</td>
<td>Creates and edits linear, parallel, radial, and diameter dimensions.</td>
</tr>
<tr>
<td>AMPOWERDIM_ANG</td>
<td>Creates and edits angular dimension.</td>
</tr>
<tr>
<td>AMPOWEREDIT</td>
<td>Intelligent edit command brings up the correct editing options based on the entity selected.</td>
</tr>
<tr>
<td>AMPOWERRASE</td>
<td>Used to erase AutoCAD Mechanical objects.</td>
</tr>
<tr>
<td>AMPOWERENCEAL</td>
<td>Recalls (reissues) the command used to create the selected entity.</td>
</tr>
<tr>
<td>AMPOWERSNAP</td>
<td>Enhances osnap settings with object snap modes, polar snap, and filters.</td>
</tr>
<tr>
<td>AMPOWERVERVIEW</td>
<td>Creates a top or side view of a standard part from an already placed orthographic view.</td>
</tr>
<tr>
<td>AMPROJO</td>
<td>Sets the projection on or off.</td>
</tr>
<tr>
<td>AMPSNAP1</td>
<td>User-defined Power Snap setting.</td>
</tr>
<tr>
<td>AMPSNAP2</td>
<td>User-defined Power Snap setting.</td>
</tr>
<tr>
<td>AMPSNAP3</td>
<td>User-defined Power Snap setting.</td>
</tr>
<tr>
<td>AMPSNAP4</td>
<td>User-defined Power Snap setting.</td>
</tr>
<tr>
<td>AMPSNAPCEN</td>
<td>Snaps to the center or other areas of a rectangle.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AMPSNAPCOORDO</td>
<td>Displays or hides the coordinates of the current cursor location while dragging the mouse cursor.</td>
</tr>
<tr>
<td>AMPSNAPFILTERO</td>
<td>Switches the entity filter on or off.</td>
</tr>
<tr>
<td>AMPSNAPMID</td>
<td>Snaps to the middle of two points.</td>
</tr>
<tr>
<td>AMPSNAPREF</td>
<td>Snaps to a reference point.</td>
</tr>
<tr>
<td>AMPSNAPREL</td>
<td>Snaps to a relative point.</td>
</tr>
<tr>
<td>AMPSNAPVINT</td>
<td>Snaps a virtual intersection point of two lines.</td>
</tr>
<tr>
<td>AMPSNAPZO</td>
<td>Allows you to switch on or off the snapping of the z-coordinate.</td>
</tr>
<tr>
<td>AMRECTANG</td>
<td>Creates rectangles from various options.</td>
</tr>
<tr>
<td>AMREFCLOSE</td>
<td>Save the reference edits.</td>
</tr>
<tr>
<td>AMREFCOPY</td>
<td>Adds an additional object to a block.</td>
</tr>
<tr>
<td>AMREV</td>
<td>Switches the revision list on or off.</td>
</tr>
<tr>
<td>AMREVLINE</td>
<td>Inserts a revision list into a drawing or adds an additional revision line to an existing revision list.</td>
</tr>
<tr>
<td>AMREVUPDATE</td>
<td>Updates the revision list.</td>
</tr>
<tr>
<td>AMSBREAK</td>
<td>Breaks the contour.</td>
</tr>
<tr>
<td>AMSCALEXY</td>
<td>Scaling in both the X and Y direction.</td>
</tr>
<tr>
<td>AMSCAREA</td>
<td>Scales selected objects in a particular area.</td>
</tr>
<tr>
<td>AMSCMONITOR</td>
<td>Scales in a viewport.</td>
</tr>
<tr>
<td>AMSSCRIPT</td>
<td>Generates the script.</td>
</tr>
<tr>
<td>AMSETUPDWG</td>
<td>Sets up a drawing.</td>
</tr>
<tr>
<td>AMSIMPLEWELD</td>
<td>Draws simple weld symbols.</td>
</tr>
<tr>
<td>AMSTDDPREP</td>
<td>Changes the representation of standard parts.</td>
</tr>
<tr>
<td>AMSTYLEITAL</td>
<td>Changes the text style to Italic.</td>
</tr>
<tr>
<td>AMSTYLESIMP</td>
<td>Changes the text style to Simplex.</td>
</tr>
<tr>
<td>AMSTYLESTAND</td>
<td>Changes the text style to Standard.</td>
</tr>
<tr>
<td>AMSTYLETXT</td>
<td>Changes the text style to TXT.</td>
</tr>
<tr>
<td>AMSURFSYM</td>
<td>Creates surface texture symbols.</td>
</tr>
<tr>
<td>AMSYMLEADER_ADD</td>
<td>Adds an additional leader to an existing leader and callout.</td>
</tr>
<tr>
<td>AMSYMLINE</td>
<td>Draws a symmetrical line.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AMSYMSTD</td>
<td>Edits and defines drafting standards for symbols.</td>
</tr>
<tr>
<td>AMTABLET</td>
<td>Determines the tablet configuration.</td>
</tr>
<tr>
<td>AMTBFULL</td>
<td>Displays the Mechanical Express Toolbar at the right side and the Snap Toolbar at the left side.</td>
</tr>
<tr>
<td>AMTBLEFT</td>
<td>Places the Mechanical Express Toolbar at the left side.</td>
</tr>
<tr>
<td>AMTBRIGHT</td>
<td>Places the Mechanical Express Toolbar at the right side.</td>
</tr>
<tr>
<td>AMTEXTITAL</td>
<td>Sets the text font to italic.</td>
</tr>
<tr>
<td>AMTEXTSIMP</td>
<td>Sets the text font to simplified.</td>
</tr>
<tr>
<td>AMTEXTSTAND</td>
<td>Sets the text font to standard.</td>
</tr>
<tr>
<td>AMTEXTTXT</td>
<td>Sets the text font to txt.</td>
</tr>
<tr>
<td>AMTITLE</td>
<td>Inserts a title block and a drawing border.</td>
</tr>
<tr>
<td>AMTRCONT</td>
<td>Creates closed contours (from construction lines).</td>
</tr>
<tr>
<td>AMUBHOLE</td>
<td>Inserts user-defined blind holes.</td>
</tr>
<tr>
<td>AMUCOUNTB</td>
<td>Inserts user-defined counterbores.</td>
</tr>
<tr>
<td>AMUCOUNTS</td>
<td>Inserts user-defined countersinks.</td>
</tr>
<tr>
<td>AMUOBLONGB</td>
<td>Inserts user-defined blind slots.</td>
</tr>
<tr>
<td>AMUOBLONGT</td>
<td>Inserts user-defined through slots.</td>
</tr>
<tr>
<td>AMUSERHATCH</td>
<td>Inserts a user-defined hatch.</td>
</tr>
<tr>
<td>AMUTHOLE</td>
<td>Inserts user-defined through holes.</td>
</tr>
<tr>
<td>AMVARIODB</td>
<td>Parts library.</td>
</tr>
<tr>
<td>AMVIEWALL</td>
<td>Zooms all viewports.</td>
</tr>
<tr>
<td>AMVIEWCEN</td>
<td>Shows the center of the drawing title.</td>
</tr>
<tr>
<td>AMVIEWLL</td>
<td>Zooms the predefined lower-left quarter of the drawing.</td>
</tr>
<tr>
<td>AMVIEWLR</td>
<td>Zooms the predefined lower-right quarter of the drawing.</td>
</tr>
<tr>
<td>AMVIEWUL</td>
<td>Zooms the predefined upper-left quarter of the drawing.</td>
</tr>
<tr>
<td>AMVIEWUR</td>
<td>Zooms the predefined upper-right quarter of the drawing.</td>
</tr>
<tr>
<td>AMVPORT</td>
<td>Creates a viewport.</td>
</tr>
</tbody>
</table>
Chapter 2  If you are New to AutoCAD Mechanical

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMVPORTAUTO</td>
<td>Command to create the viewport automatically.</td>
</tr>
<tr>
<td>AMVPZOOMALL</td>
<td>Zooms all viewports.</td>
</tr>
<tr>
<td>AMWELDSYM</td>
<td>Inserts a welding symbol into a drawing.</td>
</tr>
<tr>
<td>AMXREFSET</td>
<td>Controls the representation of xrefs.</td>
</tr>
<tr>
<td>AMZIGZAGLINE</td>
<td>Allows you to draw a zigzag line.</td>
</tr>
<tr>
<td>AMZOOMVP</td>
<td>Zooms an area in a viewport.</td>
</tr>
</tbody>
</table>

**AutoCAD Mechanical 2000 - Configuration Examples**

We have listed a number of configuration examples that cover often asked questions.

All examples are set in the Mechanical Options dialog box.

Use the AMCONFIG command to display the Mechanical Options dialog box.

**Menu**  Assist > Mechanical Options  
**Command**  AMCONFIG

**Change the Color of Dimension Text and Lines of a Diameter Dimensioning**

Choose the Dimensioning tab.

If you want to use your own Base Dimension Style enter a name in the Base Dimension Style field.
Choose the Styles... button.
In the Dimension Styles dialog box, select diameter and right-click.

From the context menu, select Modify.
In the Modify Dimension Style dialog box, choose the Lines and Arrows tab.

In the Color list for Dimension Lines, select color (red).

Choose the Text tab.

Change the text color to blue, and the text height to 5.
Change the Color and the Lineweight of a Layer

In the Mechanical Options dialog box, choose the General tab. Choose the Layer/Objects Settings… button.

Click the Lineweight column of layer AM_0 and change the lineweight to 0.35 mm.

Click in the Color column of layer AM_0. In the Select Color dialog box, select red and choose OK.
About AutoCAD Mechanical 2000 Power Pack

Functionality Overview

The AutoCAD Mechanical 2000 Power Pack extends the basic drawing, dimensioning and documentation functionality of AutoCAD Mechanical 2000 by providing features for getting the most out of the intelligent standard parts in your drawing as well as engineering features for optimizing your design. The AutoCAD Mechanical 2000 Power Pack includes all of the functionality of AutoCAD Mechanical 2000 plus key new functionality in the four areas listed below.

2D Standard Parts

Rather than generating the a portion from scratch, use the parametrically generated, intelligent geometry found in the Power Pack:

- **Standard Parts** contains half-a-million intelligent standard parts including screws, nuts, washers, pins, rivets, bushings, rings, seals, bearings and others.

- **Standard Features** contains 8,000 intelligent standard features including slots, centerholes, undercuts, keyways and thread ends.

- **Standard Holes** contains over 20,000 intelligent standard holes including through holes, blind holes, counterbored holes, countersunk holes and others.

- **Standard Structural Steel Shapes** contains over 44,000 intelligent standard structural steel shapes.
**Standard Part Tools**

Almost more important than the standard parts are the tools designed for them. After all, how often does a design call for a screw without an accompanying hole? In AutoCAD Mechanical 2000 these tools include:

- **A Screw Connection** for inserting complete fastener assemblies.
- **Change Representation** functionality for changing the representation of your standard parts between, for example, a detail of a simplified representation.
- **The Power View** function for deriving associative orthographic views, for example, a side view of a shaft from the front view.

**Machinery Systems Generators**

Machines that have movement require systems to transfer power and motion. AutoCAD Mechanical 2000 Power Pack offers the following tools to help save you time and reduce your error when designing these types of systems:

- **Shaft Generator** creates shafts with commonly found features including centerholes, chamfers, cones, fillets, grooves, profiles, threads, undercuts, and wrench fittings. In addition, standard parts such as bearings, gears, retaining rings and seals that are commonly found in shafts are also available.
- **Spring Generator** calculates, selects and inserts compression, extension and/or torsion springs in a design. The representation type of the spring can be controlled by the user and a spec form can be created to incorporate in the drawing.
- **Belt and Chain Generator** calculates optimal lengths for chains and belts, creates sprockets and pulleys, and inserts chain or belt elements in your design.
Engineering Calculations

A mechanical design includes more than just proper fit and form, it also includes proper function. Insuring proper function requires incorporating Engineering know-how. AutoCAD Mechanical 2000 Power Pack provides the following tools for saving you time with your engineering calculations and insuring you get the design right the first time:

- **Shaft Calculations** include the deflection line, bending moment, torsion moment, supporting force, torque rotation angle, equivalent tension and safety factor for shafts.
- **Fastener Calculations** select the right size screw based on given forces, materials, and methods of tightening.
- **Bearing Calculations** select the right bearing based on load and life ratings.
- **FEA** for determining the resistance capability of an object put under a static load. This function allows you to add movable and fixed supports to the part to be analyzed and also enter stress points, lines, and areas.

Command Summary

Following is a listing of the AutoCAD Mechanical 2000 Power Pack commands and a brief description of each command. For a detailed description of each command, see online Help. Note: AutoCAD Mechanical 2000 Power Pack also includes all of the commands from AutoCAD Mechanical 2000 and AutoCAD 2000. See the online Help for information about AutoCAD 2000 Power Pack commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMADJRINGS</td>
<td>Creates adjusting rings.</td>
</tr>
<tr>
<td>AMBEARCALC</td>
<td>Conducts bearing calculations.</td>
</tr>
<tr>
<td>AMBHOLE</td>
<td>Creates blind holes.</td>
</tr>
<tr>
<td>AMBOLT</td>
<td>Creates bolts.</td>
</tr>
<tr>
<td>AMCENTERHOLE</td>
<td>Creates centerholes.</td>
</tr>
<tr>
<td>AMCHAINDRAW</td>
<td>Creates chain / sprocket and belt / pulley systems</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AMCHAINLENGTHCAL</td>
<td>Calculates and optimizes the length of chains and belts.</td>
</tr>
<tr>
<td>AMCLOSINGCOMP</td>
<td>Creates plugs, sealing rings, or lubricators.</td>
</tr>
<tr>
<td>AMCONICPIN</td>
<td>Creates conical pins.</td>
</tr>
<tr>
<td>AMCOTTERPIN</td>
<td>Creates cotter pins.</td>
</tr>
<tr>
<td>AMCOUNTB</td>
<td>Creates counterbored holes.</td>
</tr>
<tr>
<td>AMCOUNTS</td>
<td>Creates countersunk holes.</td>
</tr>
<tr>
<td>AMCRIVET</td>
<td>Creates countersunk rivets.</td>
</tr>
<tr>
<td>AMCYLPIN</td>
<td>Creates dowel and grooved pins.</td>
</tr>
<tr>
<td>AMDRIBUSH</td>
<td>Creates drill bushings.</td>
</tr>
<tr>
<td>AMDRIBUSHHOLE</td>
<td>Creates drill bushings with holes.</td>
</tr>
<tr>
<td>AMEXTHREAD</td>
<td>Creates external threads.</td>
</tr>
<tr>
<td>AMFEA2D</td>
<td>Conducts 2D finite element analysis.</td>
</tr>
<tr>
<td>AMGROOVE</td>
<td>Creates retaining rings and circlips.</td>
</tr>
<tr>
<td>AMINTHREAD</td>
<td>Creates internal threads.</td>
</tr>
<tr>
<td>AMLUBRI</td>
<td>Creates lubricators.</td>
</tr>
<tr>
<td>AMNAILPIN</td>
<td>Creates nail pins.</td>
</tr>
<tr>
<td>AMNUT</td>
<td>Creates nuts.</td>
</tr>
<tr>
<td>AMOBLONGB</td>
<td>Creates blind slots.</td>
</tr>
<tr>
<td>AMOBLONGT</td>
<td>Creates through slots.</td>
</tr>
<tr>
<td>AMPIN</td>
<td>Creates dowel pins, cotter pins, taper pins, and grooved driven studs (nail pins).</td>
</tr>
<tr>
<td>AMPLBEAR</td>
<td>Creates plain bearings.</td>
</tr>
<tr>
<td>AMPLRIVET</td>
<td>Creates plain rivets.</td>
</tr>
<tr>
<td>AMPUG</td>
<td>Creates plugs.</td>
</tr>
<tr>
<td>AMRIVET</td>
<td>Creates rivets.</td>
</tr>
<tr>
<td>AMROLBEAR</td>
<td>Creates roller bearings.</td>
</tr>
<tr>
<td>AMSCREW</td>
<td>Creates screws.</td>
</tr>
<tr>
<td>AMSCREWCON</td>
<td>Insert a complete screw connection assembly.</td>
</tr>
<tr>
<td>AMSCREWMACRO</td>
<td>Inserts user-defined screw connections.</td>
</tr>
<tr>
<td>AMSEAL</td>
<td>Creates seals.</td>
</tr>
<tr>
<td>AMSEALRING</td>
<td>Creates sealing rings.</td>
</tr>
<tr>
<td>AMSHAFT2D</td>
<td>Create shafts and shaft components.</td>
</tr>
<tr>
<td>AMSHAFTCAL</td>
<td>Performs shaft calculations.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>AMSHAFTEND</td>
<td>Creates broken view shaft ends.</td>
</tr>
<tr>
<td>AMSHAFTKEY</td>
<td>Creates parallel or woodruff keys.</td>
</tr>
<tr>
<td>AMSHAFTLNUT</td>
<td>Creates shaft lock nuts.</td>
</tr>
<tr>
<td>AMSHIMRING</td>
<td>Creates shim rings.</td>
</tr>
<tr>
<td>AMSIMPLEWELD</td>
<td>Creates seams and simple welds.</td>
</tr>
<tr>
<td>AMSPRING</td>
<td>Creates springs and spring forms.</td>
</tr>
<tr>
<td>AMSPROCKET</td>
<td>Draws a sprocket or a pulley.</td>
</tr>
<tr>
<td>AMSTDDHOLE</td>
<td>Creates standard holes.</td>
</tr>
<tr>
<td>AMSTDDPLIB</td>
<td>Shows all available standard parts.</td>
</tr>
<tr>
<td>AMSTLSHAP</td>
<td>Creates standard structural steel shapes.</td>
</tr>
<tr>
<td>AMTHOLE</td>
<td>Creates standard through holes.</td>
</tr>
<tr>
<td>AMTHRHBHOLE</td>
<td>Creates threaded blind holes.</td>
</tr>
<tr>
<td>AMTHREADEND</td>
<td>Creates thread ends.</td>
</tr>
<tr>
<td>AMUNDERCUT</td>
<td>Creates undercuts features.</td>
</tr>
<tr>
<td>AMWASHER</td>
<td>Creates washers.</td>
</tr>
</tbody>
</table>
AutoCAD Mechanical 2000 Power Pack – Configuration Examples

We have listed a number of configuration examples that covers often asked questions.

All examples are set in the Mechanical Options dialog box.

Use the AMCONFIG command to display the Mechanical Options dialog box.

Menu  Assist > Mechanical Options
Command  AMCONFIG

Change the Representation Type of Standard Parts

Choose the Part Appearance tab.

In the 2D Representation box, change the representation.

Set Available Standard Systems

Choose the Part Settings tab.

In the Available Standard list all installed standards are displayed, but they need not to be set. If this list is empty all standards are set.

Select the standards you want to set (we use the ANSI standard here) and press the arrow button.
Order of Selecting Standards

Choose the Part Settings tab.

In the Selected Standard list, all set standards are displayed. The order of the standards determine the sequence, in which the standards are offered.

To change the sequence of the standards, select the standard system you want (in our example the ANSI standards shall be displayed first).

Press the arrow button until ANSI is on the top of the list.
Now, if you insert a standard part, ANSI is always offered first.
Experienced with Genius

This chapter contains information about general changes, migrating drawings created with Genius 13/14 to AutoCAD Mechanical 2000, and a listing of revised commands.

- General Changes
- Migrating Genius Drawings to AutoCAD Mechanical 2000
- Revised Commands
**General Changes**

We've made some innovations that make your work even faster and more efficient.

In this chapter we have assembled a list of those changes and other helpful information so that you can get started in this version of AutoCAD Mechanical right away.

**Working with Previous Versions of Genius**

AutoCAD Mechanical 2000 uses a new drawing format.

With this new format you can save your AutoCAD Mechanical 2000 drawing in a format of previous AutoCAD releases. Object information can also be changed.

Because of this new format you can migrate the drawings created with previous version including Genius13 and/or Genius14. This migration can be done by AMMIGRATEBB for the parts list, infopoints and position numbers. Use AMMIGRATESYM to migrate the symbols for example the surface textures and/or the geometric tolerances. The automatic migration can also be done by AMSCRIPT, which can migrate more than one drawing.

**Issuing Commands**

AutoCAD Mechanical now provides four methods for invoking commands. You can select from a menu, from a toolbar, from the tablet, or you can enter the command on the Command line.

All commands start with AM; for example **AMLAY**, to open the Layer and Layer Group Control dialog box.

Chapter 2 *If you are New to AutoCAD Mechanical* lists all AutoCAD Mechanical commands in alphabetical order separated in commands for AutoCAD Mechanical on page 15 and the AutoCAD Mechanical Power Pack Package on page 28.
Menu and Toolbar Changes

All commands have been regrouped and integrated into the AutoCAD menu. This means for example, that commands used for creating lines such as Symmetrical Lines, Centerlines, and Construction Lines, are grouped on the Design menu, and commands used for making modifications such as Chamfer are grouped on the Modify menu. Typically, machine engineering commands such as standard parts and calculations are grouped on the Content menu.

The toolbars have also been rearranged. You will start with an express toolbar at the left side including design, assistance, annotation, and content commands. Use AMTLEFT, AMTBRIGHT and AMTBFULL, under View > Toolbars to rearrange the Express toolbars.

Full Support of Templates

In the previous versions of AutoCAD Mechanical, the configuration was stored in the GE?prese.cfg files, and you were limited only one configuration per installed version. Now, the configuration can be saved in a template drawing (DWT), so you can have more than one configuration on a system. Also, you can override within an existing drawing, using of the AMSETUPDWG command.

Remove of Redefined Commands

The redefined commands have been eliminated, so you no longer have “double” commands such as GENLINE and LINE.

Network Installation Capability for Standard Parts

During installation, you can specify to install the software locally and the standard parts on the network. This capability is provided to help ensure that there will be only one standard part database for all users.
Migrating Genius Drawings to AutoCAD Mechanical 2000

This chapter contains information about migrating drawings created with Genius 13/14 to AutoCAD Mechanical 2000. It contains a tutorial-like exercise about the different migration possibilities.

- Important Information
- Migrating layers and drawing settings
- Migrating parts list information
- Migrating Symbols
- Purging after migration
- Migrating standard parts
- Migrating blocks
- Using the script generator for single step migration
Important Information

Drawing Format
AutoCAD Mechanical 2000 uses a new drawing format.
With this new format you can save your AutoCAD Mechanical 2000 drawing in a format of previous AutoCAD release. Object information can also be changed.

Migration
You are able to migrate Genius drawings in different ways.
Because of the many new and optimized features, you have the possibility to migrate only parts of the drawing by using different commands.
A tool within the script generator enables you to run these commands by a script and migrate your drawings completely in one step.
These possibilities let you decide whether you

- don’t want to migrate (to make only a few changes)
- want to migrate partially (depending on your needs)
- want to migrate completely (to use all new functionality)
Migrating Layers and Drawing Settings

AutoCAD Mechanical 2000 has a new, improved layer structure and renamed layers.

Now, the predefined layers have the prefix AM_* to indicate that they are AutoCAD Mechanical layers. Some of the layer names have been changed to more meaningful names; for example from KLIN to AM_CL for centerlines, and from INFO to AM_PAREF for part references.

When you start a new drawing in AutoCAD Mechanical 2000, the new layer structure is used.

If you want to continue to working on a Genius drawing in AutoCAD Mechanical 2000, and use the new layer structure, you have to migrate the drawing:

First, you setup your drawing with a template file, which contains the new drawing settings like the layer structure.

1. Open the drawing migration.dwg in the acadm/tutorial folder.

   Toolbutton: Open
   Menu: File > Open
   Command: OPEN

   The drawing is generated with Genius 14 and contains a pulley assembly with previous layer structure, infopoints, balloons, parts lists, symbols and drawing border.

2. Start the Setup Drawing command.

   Menu: Assist > Format > Setup Drawing
   Command: AMSETUPDWG

3. Respond to the prompt as follows:

   Template drawing (Enter . for none) <.:> ENTER ~

   In the Select Template Drawing dialog box, select the template am_iso.dwt, and choose Open.
4 Respond to the prompt as follows:

Update layer/object settings according to template? [Yes/No] <Yes>: Press ENTER

**TIP** If you have defined a default template in the Mechanical Configuration, the template name and path will be displayed on the command line and you only have to press ENTER.

The layers are migrated. Open the Layer Control dialog box, to see the results.

5 Start the Layer Control command.

**Toolbutton** Layer Control

**Menu** Assist > Layer / Layergroup > Layer/Layer Group Control

**Command** AMLAY

The Layer Control dialog box opens.
You can see that the layers have been changed to the new layer structure.

6. Choose OK to return to the drawing.

**NOTE** If your drawing contains Genius standard parts, the standard part layers cannot be migrated and deleted, unless the standard parts have also been migrated.

**Migrating Parts List Information**

AutoCAD Mechanical 2000 offers a new functionality for working with parts list information. This functionality is based on the Mechanical Desktop and AutoCAD Mechanical 14.5 concept. It is enhanced by many features of the Genius functionality.

These new features are in detail:

- All parts list information is stored in a drawing-dependent database (BOM database)
- The database manages your data very flexible in spread-sheet-like dialog boxes
- Associativity between all data (BOM database, parts list, part reference, balloon)
- Associativity requires no data update
- Part references contain the part data (instead of infopoints)
- Standard-related settings for BOM data and parts list information

**Using the AMMIGRATEBB Command**

This command migrates a Genius parts list to the new AutoCAD Mechanical 2000 format.

After migration, command line messages indicate if problems occurred during migration. This may happen if Genius drawing is corrupt; the messages show you more detailed information. If no messages are displayed on the command line, the migration was successful. All old parts list elements are replaced in the following way:

Genius infopoints are converted to part references.

**NOTE** Part references stay resident in the drawing even if they are ballooned; this behavior is different from Genius.
Genius balloons are converted to part references and balloons.

**NOTE** AutoCAD Mechanical 2000 supports standard balloons and custom-block defined balloons; custom-block defined balloons are used for migration to ensure that your drawing looks like the previous drawing.

Genius parts lists are converted and become a drawing object.

**NOTE** AutoCAD Mechanical 2000 supports standard parts lists and custom-block defined parts lists; custom-block defined parts lists are used for migration to ensure that your drawing looks like the previous drawing.

A database is automatically created in the background and provides you with the full functionality and associativity of your data.

All parts list information is migrated to a standard. If the existing drawing is metric, it will be migrated to ISO standard; if it is inch, it will be migrated to ANSI standard.

**TIP** The system variable delobj (default value = 1) controls the removal of the old elements. Set the variable to 0 if you do not want that old elements be deleted.

Continue to work with the drawing *migration.dwg*.

Perform the following steps to learn migrating a parts list.

1. Start the AMMIGRATEBB command.
   
   **Command** AMMIGRATEBB
   
   The appearance of the drawing has changed slightly.
   
   - The Genius infopoints were changed to part references.
   - The Genius balloons were changed to part references and balloons.

   Now, have a look at the BOM database.

2. Start the Edit BOM Database command.
   
   **Toolbutton** Edit BOM Database
   
   **Menu** Annotate > BOM Database
   
   **Command** AMBOM

3. Respond to the command line prompt as follows:

   Bom table [Delete/Edit] <Edit>: Press ENTER

   The BOM dialog box displays the BOM database.
The BOM-database dialog box created during migration. All Genius columns are generated (Use the scrollbars to see the columns or resize the dialog). It includes all data from the existing drawing.

In the left pane, you see the entries BOM1 and BORDER1.

These are different BOM databases, which have been generated during migration.

BOM1 is the MAIN-BOM and includes the part references in the drawing.

BORDER1 is a BORDER-BOM and includes the part references inside the border.

Select BOM1 or BORDER1 to see the different BOM-databases.

In this example MAIN and BORDER contain the same information since there are no part references outside the border.

In case of more borders in a drawing, the result will be BOM1, BORDER1, BORDER2, BORDER3, … with different BOMs.

4 Press OK to return to the drawing.

Now, have a look at a part reference.

5 Start the Edit Part Reference command.

- **Toolbutton**: Edit Part Ref Data
- **Menu**: Annotate > Edit BOM Attributes
- **Command**: AMPARTREFEDIT
6 Respond to the command line prompt as follows:

Select pick object:  Select the part reference symbol of the clevis pin, item number 5

**TIP** Double-click the part reference you can edit it.

The Part Ref Attributes dialog box is displayed.

The Part Ref Attributes dialog box contains the Genius columns with the entries belonging to it. You can change the data of a single part reference associatively. This dialog box also appears if you create a new part reference.

7 Choose OK to return to the drawing.

Now, have a look at the parts list.
8 Start the Edit Part List/Balloon command.

   **Toolbutton**    Edit Part List/Balloon
   **Command**       AMEDIT

9 Respond to the Command prompt as follows:

Select object:  *Select the parts list*

   **TIP**  A double-click (Power Edit) on the parts list enables you to edit the parts list as well.

The Parts List dialog box is displayed.

The Parts List dialog box contains the parts list info of the selected parts list.

This parts list refers to the BORDER1 database (it is an extract from the database).

You can change the data (associative) or the representation for each parts list in this dialog box.

The parts list has been migrated as a custom-block defined parts list as you can see from the entry GENBPOS in the list box at the right top corner. Besides the custom-block GENBPOS, you can select Standard or Others from the list to use a standard parts list or another custom-block defined parts list.

The Genius columns defined in this block are displayed in this dialog box (use the scrollbars to see the columns or to resize the dialog box).

You can define different filters for each parts list.
During migration, a parts filter is used to create a parts list from several part references in the drawing, if your drawing contains infopoints that are not ballooned and are not in the parts list. They will be migrated to part references, but they will be excluded from the parts list using this filter.

10 In the Filter field is a check box for parts. Select this check box, and choose Apply, to see the part references inside the border.

In the example, one unballooned infopoint is converted to a separate part reference.

Checked/unchecked filter (Apply) shows this part in the dialog

11 Clear the Parts check box in the Filter field, and choose Apply.

Now, the unballooned part reference of the base plate will be displayed in the dialog.

12 Choose OK to return to the drawing.

The parts list in the drawing is updated.

Now, look at a balloon.

13 Start the Edit Part List/Balloon command.

14 Respond to the Command prompt as follows:

Select object:  *Select balloon number 1*

TIP You can double-click the balloon to edit it.

The Balloon dialog box is displayed.
The Balloon data refers to both the balloon and the part reference. You can change the data (associative) or the representation for each balloon in this dialog box.

The balloon has been migrated as a custom-block defined balloon. The entry AMMIGR0 in the list box in the upper-right corner indicates that a custom-block is created for each balloon during migration. This is necessary to ensure that your migrated drawing looks like it did prior to the migration. Besides the custom-blocks, which are defined in the drawing, you can select Standard Balloon to use a standard-based balloon from the list box.

All Genius columns are shown in this dialog box, which contains the entries of the part reference belonging to it. (Use the scrollbars to see the columns or to resize the dialog box).

15 Press OK to return to the drawing.

**Editing the Parts List**

You migrated parts list information from Genius to AutoCAD Mechanical 2000. Now, you will edit the parts list information as described to learn about the different editing possibilities.

First, you create a new balloon for the single part reference of the base plate in the drawing.

1 Start the Place Balloon command.

   **Toolbutton** Place Balloon
   **Menu** Annotate > Place Balloon
   **Command** AMBALLOON

2 Respond to the Command prompt as follows:

   Select part/assembly or [Auto/Collect/Manual/One/Renumber]: Enter O
   Select pick object: Select the part reference symbol of the base plate, P1
   Select a start point of balloon: Press ENTER
   Next Point: Specify the balloon location, P2
   Next Point: Press ENTER
   Select pick object: Press ENTER
Balloon 8 is inserted into the drawing. It looks different from the migrated balloons 1 through 7, because the new balloon is created from standard, and not from a custom-block. Edit the balloon to see the difference.

3 Double-click balloon 8.

The Balloon dialog box is displayed. The list box in the upper-right corner indicates that the balloon is created from standard.

4 Press OK to return to the drawing.

Now, change the migrated balloons 1 through 7 to standard.
NOTE Different balloons can have different balloon representations. Changing the representation in the dialog box changes only one balloon. Changing the standard changes all balloons referring to the standard.

5 Start the Match Properties command.

- **Toolbutton**: Match Properties
- **Menu**: Modify > Properties > Match Properties
- **Command**: MATCHPROP

6 Respond to the Command prompt as follows:

Select source object:  *Select balloon 8*
Select destination object(s) or [Settings]:  *Select balloons 1 through 7*
Select destination object(s) or [Settings]:  *Press ENTER*

Balloons 1 through 7 are changed to the standard representation of balloon 8.

Now, change the standard balloon to a different representation.

7 Start the Mechanical Options command.

- **Menu**: Assist > Mechanical Options
- **Command**: AMCONFIG

8 In the Mechanical Options dialog box, General tab, select Symbol/BOM Standards.
9 In the Symbol Standards dialog box, double-click entry Balloon ISO 6433 – 1981.

10 In the Balloon Properties for ISO dialog box, Standard Balloon section, choose the balloon icon.
11 Select the upper right balloon type Open.

12 Choose OK to close all dialog boxes.

All balloons have been changed to the new standard balloon type, Open.

Now you, create a second, standard-based parts list in the drawing.

**Creating and Inserting Another Standard Parts List**

1 Start the Mechanical Options command.
   
   **Menu**  Assist > Mechanical Options
   
   **Command**  AMCONFIG

2 In the Mechanical Options dialog box, General tab, select Symbol/BOM Standards.
In the Symbol Standards dialog box, double-click entry ISO 7573 - 1983.

The BOM Properties for ISO dialog box opens.
The settings in the BOM Properties for ISO dialog box are the standard settings for the BOM after the migration. All columns in your Genius drawing have been converted and added to this standard BOM setting. Using this dialog you can easily change the standard settings.

You can also restore the default settings, which are used when starting a new drawing, by pressing the Default button. To see the differences between the migrated parts list and a default parts list, change to the default settings and insert a second parts list using those default settings.

4 In the BOM Properties for ISO dialog box, choose the Default button.

As you can see, the Genius columns have been removed so that the dialog box represent only the default columns.

**NOTE** Changing to the default settings, also changes the balloon type back to Circular.

5 Choose OK to close all dialog boxes.

Now, insert the second parts list that uses the default settings.

6 Start the Parts List command.

<table>
<thead>
<tr>
<th>Toolbutton</th>
<th>Place Parts List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>Annotate &gt; Parts List &gt; Parts List</td>
</tr>
<tr>
<td>Command</td>
<td>AMPARTLIST</td>
</tr>
</tbody>
</table>

52 | Chapter 3 Experienced with Genius
7 Using the AMMIGRATEBB Command

Respond to the command line prompt as follows:

Select border:  *Select the drawing border*

Part list name <Parts List>:  *Press ENTER*

Select type of Parts List:  [All/Parts/Range] <All>:  *Press ENTER*

Specify location or ENTER to Right direction:  *Specify a location in the lower left corner of the drawing border*

The default parts list is inserted.

```
<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>1</td>
<td>Cylinder Head Cap Screw</td>
<td>DIN 7981L - M6 x 25</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>Cylinder Head Cap Screw</td>
<td>DIN 7981L - M6 x 14</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>Knurled pin</td>
<td>ISO 2261 - A - 16 x 61</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>Shim ring</td>
<td>DIN 988 - 12 x 24 x 2</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>Bush</td>
<td>DIN 1851 - G 16 x 22 x 20 Copper alloy</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Shim ring</td>
<td>DIN 988 - 12 x 24 x 2</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Cylinder Head Cap Screw</td>
<td>DIN 7981L - M6 x 14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Base plate</td>
<td></td>
</tr>
</tbody>
</table>

Item Description | Standard | Material |
|-----------------|----------|----------|
```

Notice the differences from the migrated parts list. The Parts List dialog box is different as well.

8 Double-click the previously inserted parts list.

The Parts List dialog box opens.
This parts list works with only a few columns; however the layout is simple to adapt or expand to your requirements, using BOM-Properties-, Parts List Properties, and Parts List dialog boxes.

The custom-block defined parts list works with a fixed layout and columns, which are defined in blocks.

Depending on your requirements and the number of columns used, you need to choose between the following possibilities:

- Using a standard parts list,
- using a custom-block defined parts list, or
- using different representations of parts lists in one drawing

Press OK to return to the drawing.

**Changing the Standard Parts List to a Custom Parts List**

Now, you will change the standard parts list to a custom-defined parts list.

1. Start the Mechanical Options command.
   - **Menu**: Assist > Mechanical Options
   - **Command**: AMCONFIG

2. In the Mechanical Options dialog box, General tab, choose Symbol/BOM Standards.

The Parts List Properties for ISO dialog box opens.

In the Parts List Properties for ISO dialog box, you can change the settings for a standard based parts list. Changed settings will become effective if you inserted a new standard-based parts list.

4 Select the Custom Blocks tab.
In this dialog box, you can define or change the settings for a custom-block defined parts list, by selecting the Use Custom Block for Parts List checkbox. Changed settings will become effective if you inserted a new custom-block defined parts list.

Choose OK to close all dialog boxes.

**More Information About Migrating Parts List Information**

**Genius.txt Files**

During parts list creation in Genius, a file containing the parts list information was generated. By default, the file name was the name of the drawing with the extension \texttt{txt}.

AutoCAD Mechanical 2000 does not support this functionality, because the parts list information is contained in the BOM database. However, a new function supports exporting and importing database data.

The following options are available in both the BOM dialog box and the Parts List dialog box:

- **Export**
  - Choose this button to export database information to a file.

- **Import**
  - Choose this button to import database information from a file.

Choosing the export button opens the Export dialog box.
Here, you can enter a file name and select the file type from a drop-down list.

**Genius Expand Function**

Genius provided a function that expanded parts lists with data from other drawings by using .txt files. Therefore, the Genius infopoint contained path and name of the .txt file. Since AutoCAD Mechanical 2000 does not support this functionality, you can attach a drawing as for example a “Blind XREF”.

The drawing is loaded as an invisible XREF, and the BOM database containing the drawing is attached to a part reference. Therefore, the Part Ref Attributes dialog box contains an Attach button.

Choose the Attach button to open the Import dialog box. Select the drawing containing parts list information you want to have, and the BOM name.

After the attachment, the Detach button becomes active.

An attached drawing is indicated by a + symbol at the beginning of the line in the BOM dialog box.
Pressing the + symbol expands this column with the BOM table from the attached drawing.

**BOM Representation**

Choose the BOM Representation button opens the BOM Representation dialog box. In the dialog box you can control the BOM representation.

![BOM Representation dialog box]

**Migrating Genius drawings with expanded parts list**

A Genius drawing with a parts list that has been expanded with a .txt file, will be migrated as follows:

If an entry is detected inside an infopoint, it will be migrated. The data from the .txt file is converted to a separate BOM table and added to the new part reference, using the Attach option.

The associativity to the other drawing is lost, because the migrated .txt file cannot be updated.

To restore the associativity to the other drawing, you have to migrate the current drawing and attach it to the part reference. The converted .txt file will be replaced by the new attachment.
Migrating Symbols

AutoCAD Mechanical 2000 offers new functionality and new dialog boxes for all symbols such as surface textures, feature control frames, datum identifiers, and welding symbols. Symbols are now related to different standards.

If you have an Genius drawing containing symbols, and you want to continue working on that drawing with AutoCAD Mechanical 2000, you can do one of the following:
- Don’t migrate the symbols. Each symbol will be recognized and migrated as soon as you use Power Edit on this symbol for the first time. Also the new dialog box appears.
- Migrate all symbols in the drawing in one step using AMMIGRATESYM.

Using the AMMIGRATESYM Command

This command migrates Genius symbols to the new AutoCAD Mechanical 2000 format.

After migration, command line messages indicate the number of found and migrated symbols. If some Genius symbols cannot be migrated, you will be notified about this in the command line.

All symbols are migrated to the current symbol standard in the drawing.

Now, you will migrate symbols. You will continue to work with the drawing migration.dwg.

1 Start the AMMIGRATESYM command.
Command AMMIGRATESYM

All symbols in the drawing are converted.

| Command: ammigratesym | Found symbols: 7 | Migrated symbols: 0 | Symbols that couldn’t be migrated: 0 |

In the next step, you perform a Power Edit on the various symbols so that you can look at the new dialog boxes.

2 Double-click a surface texture symbol in the drawing.
Chapter 3  Experienced with Genius

3 Choose OK to return to the drawing.

4 Double-click the datum identifier symbol in the drawing.

5 Choose OK to return to the drawing.
6 Double-click the feature control frame in the drawing.

The Feature Control Frame dialog box opens.

7 Choose OK to return to the drawing.

## Purging After Migration

During migration, a lot of unused layers and blocks are accumulated and need to be removed to reduce the size of the drawing. This can be done using the Purge command.

**NOTE** The AutoCAD Mechanical 2000 Purge command differs from the AutoCAD 2000 Purge command. AutoCAD Mechanical 2000 cycles this command through all levels until all objects are purged.

1 Start the Purge command.
   - **Menu** File > Drawing Utilities > Purge
   - **Command** AMOBJPURGE

2 In the Purge dialog box, choose the Purge button.
The purging starts, and the results are displayed in the Info section of the Purge dialog box.

3 Choose OK to return to the drawing.

**Migrating Standard Parts**

The standard parts in AutoCAD Mechanical 2000 have a different internal format than the standard parts (custom entity) in Genius.

Generally, it is not necessary to migrate standard parts to AutoCAD Mechanical 2000 format, because you can always edit existing Genius standard parts.

So, forget about migrating standard parts, and continue to work on your drawing. Once you edit a standard part using Power Edit, the part will be recognized and changed to the new format.

**Migrating Blocks**

AutoCAD Mechanical 2000 has new block names for several functions.

The predefined blocks have the prefix `AM_*` to indicate that they are AutoCAD Mechanical blocks.

Generally, it is not necessary to migrate block names to AutoCAD Mechanical 2000 format, because the functionality does not change.

If you create a new drawing in AutoCAD Mechanical 2000, the new block names are used. If you use functionality that uses new blocks, you can replace blocks or leave blocks as they were.
Now you will change the drawing border block.

1. Double-click the drawing border.

2. In the Drawing Borders with Title Block dialog box, select the Title Block AMTITLE and the Paper Format AM_A3. Choose OK.

3. Respond to the prompt as follows:

   Objects for centering and rescaling:
   Select objects: Press ENTER

   The drawing border is replaced by the new drawing border block.

   **NOTE** You can use the Purge command to purge the old, unused blocks.

**Using the Script Generator for One-Step Migration**

Instead of converting a drawing step by step or partially you can convert one or more drawings in only one step.

If you followed the migration steps, using the example drawing migration.dwg, you can easily understand how this tool converts your old Genius drawings.

**ATTENTION** Before you migrate multiple drawings, we recommend that you back up the files. The files, which are saved in the new format, cannot be opened directly in former Genius releases.
The script generator creates a script file from a selected function. It runs the script file with the preselected drawings. The Migrate option (in the script generator dialog box) is used to convert Genius drawings to AutoCAD Mechanical 2000.

The function Migrate

- Opens the drawing
- Sets up the drawing with a template file (AMSETUPDWG)
- Migrates the parts list information (AMMIGRATEBB)
- Migrates the symbols (AMMIGRATESYM)
- Purges the drawing (AMOBJPURGE)
- Saves the drawing in the new format (with the same name)

Details on using the script generator for migrating Genius drawings are explained in the following.

**NOTE** Depending on the drawing selection or the AutoCAD Mechanical 2000 installation path, the entries in the dialog boxes may look different.

Before running the script generator: Be sure that a default template is defined in the Mechanical Options dialog box (this template is used as long as it is specified there; you can remove it later).

**NOTE** Close the drawing to be migrated, if it is open.

Now, specify a default template.

1. Start the Mechanical Options command.
   - **Menu** Assist > Mechanical Options
   - **Command** AMCONFIG

2. In the Mechanical Options dialog box, General tab, choose Browse.

3. In the Open dialog box, select the default template *am_iso.dwt*. Choose Open.
The entry for the default template is displayed in the Mechanical Options dialog box.

4 Choose OK.

   **NOTE**  Now, the template am_iso.dwt is specified as the default template for both migration and a new drawing.

Now start the script generator.

5 Start the Script Generator command.

   Menu  Assist > Script > Script Generator

   Command  AMSCRIPT

6 In the Script Generator dialog box, select Migrate option from the Selected Function list. Then browse to the file, you want to migrate, mark the file, and choose Add. Choose OK.
7 In the Name of Script File dialog box, confirm the default name and path. Choose Save.

8 In the AutoCAD Question dialog box, choose Yes.

The script runs and the selected files are migrated.
After migration, the drawing is in AutoCAD Mechanical 2000 format.
Revised Commands

AMCONFIG

<table>
<thead>
<tr>
<th>Configures AutoCAD Mechanical</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu</strong></td>
</tr>
<tr>
<td><strong>Command</strong></td>
</tr>
</tbody>
</table>

Use AMCONFIG to set up your own defaults for working with AutoCAD Mechanical.

Mechanical Options Dialog Box

The types of options and their functionality within a tab vary, depending on the package you installed with AutoCAD Mechanical. If you installed plain AutoCAD Mechanical, with none of the Power Pack packages, only the General, Dimensioning, Part Appearance, and the Miscellaneous tabs are displayed in the dialog box. If you installed AutoCAD Mechanical with a Power Pack package, all seven tabs are displayed.

In general, these seven tabs are associated with the Mechanical Options dialog box:
- General
- Dimensioning
- Shaft Generator (with Power Pack only)
- FEA (with Power Pack only)
- Part Settings (with Power Pack only)
- Part Appearance (with Power Pack only)
- Miscellaneous

General tab
- **Standard**
  Specifies the standard to use as the default in all of your drawings.

Measurement
- **Measurement**
  Specifies the unit to use as the default in all of your drawings.

Scale
- **Scale**
  Sets the scale for the drawing in model space.
Default Template
Displays the name and the path of the additional template you are currently using as default template in conjunction with the present settings. If no default template is used, <none> is displayed in this edit field.

Layer/Object Settings
Displays the Layer/Object Settings dialog box for setting the mechanical object properties such as layer, color, linetype, and lineweight.

Symbol/BOM Standards
Displays the Symbol Standard dialog box for setting a standard for drawing symbols and bill of materials and balloons.

Drawing Sheet
Displays the Drawing Frame and Title Block dialog box.

Import
Displays the Open dialog box for selecting and importing a drawing file (*.dwg), a template drawing (*.dwt), a Genius 13/Genius 14 configuration file (*.cfg), or an AutoCAD Mechanical configuration file.

Dimensioning tab

Style Preferences

Based on Standard
Specifies the standard to use as the default for dimensions in all drawings.

Base Dimension Style
Specifies the style for dimensions to use as the default in all drawings.

Force Usage of Predefined Dimension Styles
Makes the dimension style displayed in the Base Dimension Style field the current dimension style.

Styles
Displays the Dimension Styles dialog box for selecting a dimension style.

Dimension Text
Displays text strings of the current dimension text. You can add or remove text strings to or from the dimension text.

Clear
Deletes text displayed in the Dimension Text field.
Add
Adds new text entered in the Dimension Text field to the list of predefined text strings.

Remove
Deletes the displayed text in the Dimension Text field from the list of predefined text strings.

Advanced

Fits
Displays the System Editor dialog box for editing fits.

Tolerances
Displays the System Editor dialog box for editing Tolerances.

Display the Dimension dialog box
Sets how often the Power Dimensioning dialog box is displayed during one dimensioning session: every time you place a dimension line, only when you place the first dimension line, or only on demand.

Rebuild Fitlist
Sets how fits lists are updated in the drawing: automatically; automatically, but on request; or manually.

Points instead arrows at Distance
Replaces arrows of a dimension line by points, if the distance between the arrow heads is less than the distance value you specify in this field.

Use Distance Snap
Sets a distance value at which the cursor snaps when you move the dimension line from the object being dimensioned.

Import
Displays the Open dialog box for selecting and importing a drawing file (*.dwg), a template drawing (*.dwt), a Genius 13/Genius 14 configuration file (*.cfg), or an AutoCAD Mechanical configuration file.

Shaft Generator tab

For Segment Inserted

Overdraw
Overdraws part of the existing shaft when a segment is added to that shaft.
**Insert**
Shifts the whole shaft to one side, without overdrawing it, when a segment is added to that shaft.

**Prompt**
Prompts you to choose between the Overdraw and Insert options.

**Stationary Shaft End**
Specifies which side of the shaft stays fixed when a shaft segment is added to or deleted from the shaft.

**Left**
Keeps the left side of the shaft fixed when a shaft segment is added to or deleted from the shaft.

**Right**
Keeps the right side of the shaft fixed when a shaft segment is added or deleted from the shaft.

**Prompt**
Prompts you to select the side of the shaft you want to keep fixed.

**Initial State**
Specifies the type of user interface to use for creating shafts: the command line, or the Shaft Generator dialog box.

**Command Line**
Sets the user interface to the command line for creating shafts.

**Dialog Box**
Sets the user interface to shaft generator dialog box for creating shafts.

**Side for Side View**
Specifies which representation is used when a side view of the shaft is created and inserted into the drawing: European (DIN standard) or ANSI.

**European**
Places the shaft side view in the drawing, in accordance with the European representation.

**ANSI Projection**
Places the shaft side in the drawing, in accordance with the ANSI representation.

**Front View**
**Draw as 2 Halves**
Divides the vertical line of the shaft sections at the axis into two lines of the same length.
Radius Reflection Line
Draws a reflection line when drawing the radius.

Check Contour
Checks whether the contour is broken. A broken contour is highlighted.

Adjust Centerline
Specifies whether the centerline is automatically adjusted to the length of the generated shaft.
Yes
Adjusts the centerline to the length of the generated shaft.
No
Does not adjust the centerline to the length of the generated shaft.
Prompt
Prompts you at the end of the shaft generation to select whether to adjust the centerline to the length of the shaft.

Side and Sectional Views
Specifies the way in which side and sectional views of shafts are displayed and managed in the drawing.
Complete View
Draws both side and sectional views.
Radius Reflection Line
Displays the reflection line as a circle in the side view.
Sectional with Background
Draws shaft sectional views, including views of objects in the background.
Always Update
Updates sectional and side views whenever you make changes to the shaft. If this option is not selected, you are prompted after you’ve completed editing the shaft to whether update the sides and sectional views or not.
Hidden Lines
Shows hidden lines in sectional and side views.
Move Side View
Selects a new insertion point for the side view, if the side and frontal views collide.
Interrupted View
Specifies the way in which the interrupted view is represented: Zigzag, Freehand, or Hatch.
Icon
Displays a graphical overview for the interrupted view representation displayed in the field below this icon.

Combo box
Displays the selected type of representation for the interrupted view.

**If shaft in background, hide standard parts, too**
Controls the insertion of standard parts.

Yes
Hides a standard part.

No
Inserts the standard part in the foreground.

Prompt
Asks whether a standard part should be hidden.

Import
Displays the Open dialog box for selecting and importing a drawing file (*.dwg), a template drawing (*.dwt), a Genius 13/Genius 14 configuration file (*.cfg), or an AutoCAD Mechanical configuration file.

**FEA tab**

Layer Group for FEA Task
Sets the layer group for the FEA. The default setting is the layer group AM_FEA. You can specify any other layer group to use for the FEA.

Scale Factor for Symbols
Sets the scale factor for symbols associated with the FEA calculation. This factor affects the size in which a symbol is displayed in the drawing, but not the load value associated with it.

Create Output File Automatically
Saves the results of the FEA calculation to a TXT file. The name of the file is the name of the drawing where the FEA routine is being used.

**Colors**
Sets colors for the representation of Isolines and Isoareas. You can select from 12 (VGA graphics driver) or 24 (Super VGA graphics driver) colors. To change pre-set colors, click the corresponding color field and select a new color from the color palette.

Set Default Colors
Sets colors for the representation of Isolines and Isoareas to the default colors.
**Import**
Displays the Open dialog box for selecting and importing a drawing file (*.dwg), a template drawing (*.dwt), a Genius 13/Genius 14 configuration file (*.cfg), or an AutoCAD Mechanical configuration file.

**Part Settings tab**

**Selection Group Hole**
Sets the type of holes. You can select Close, Normal, or Loose. You can also select all three types of holes at once.

- **Hole – Close**
  Sets the type of holes to close hole.

- **Hole – Normal**
  Sets the type of holes to normal hole.

- **Hole – Loose**
  Sets the type of holes to loose hole.

**Thread**
Sets the type of thread for all parts containing threads. You can select Fine or Regular. You can also select both Fine and Regular.

- **Fine**
  Sets the type of threads to fine thread.

- **Regular**
  Sets the type of threads to regular thread.

**Pre-selection**
Specifies the group of standard parts you want to make available for selection. You can create four groups of standard parts in the Value Table of the standard parts database: Company group, Standard group, a group containing both the Company and Standard group, and a group of parts you don’t want displayed for selection.

Select any of the predefined groups, or select All parts, irrespective of the group they belong to.

**Standard Settings**

- **Available Standard**
  Displays all standards installed on your system.

- **Selected Standard**
  Displays the standards you selected from the Available Standard list.

- **Add Old Standard Designations**
  Displays both old and new designations for parts in the Standard Part Value Table.
→
Adds standard to the list of Selected Standard list.
←
Removes standard from the list of Selected Standard list.
↑
Moves the selected standard upward in the list.
↓
Moves the selected standard downward in the list.

**Import**
Displays the Open dialog box for selecting and importing a drawing file (*.dwg), a template drawing (*.dwt), a Genius 13/Genius 14 configuration file (*.cfg), or an AutoCAD Mechanical configuration file.

**Part Appearance tab**

**Representation**

**Use Standard Parts Layer**
Sets parts you insert in the drawing on Standard Parts layers (layers whose names end with the letter N).

**2D Hide Background**
Makes objects in the drawing that lie behind standard parts invisible.

**2D Representation**
Specifies the way in which 2D parts are represented in the drawing.

**2D Draw Centerlines**
Inserts symmetric standard parts with their centerlines into the drawing.

**Projection Length of Centerlines**

**Fixed Size (Dependent on Scale)**
Sets the projection length of centerlines to the standard length of 3 mm. This length adjusts to the scale of the drawing.

**Proportional to Part**
Sets the projection length of a centerline in proportion to the size of the part associated with it.

**2D Representation**
Specifies the way in which 2D parts are represented in the drawing.

**3D Representation**
Specifies the way in which 3D parts are represented in the drawing.
**Enforce Projection Length Rules for Screw Connection**
Sets the projection length of centerlines for screw connections to follow a rule similar to that of VDI 2230, where the projection length of the screw centerline should have a length of 1.5 times the length of the nut associated with it.

**Import**
Displays the Open dialog box for selecting and importing a drawing file (*.dwg), a template drawing (*.dwt), a Genius 13/Genius 14 configuration file (*.cfg), or an AutoCAD Mechanical configuration file.

**Miscellaneous tab**

**Snap Settings**
Specifies the type of settings and displays the Power Snap dialog box for setting snap modes, polar snap, and filters for object snaps.

**Snap Settings – Dropdown list**
Sets object snaps to User Settings, System Settings, or turns object snaps off.

**Snap Defaults**
Displays the Power Snap Settings dialog box for setting snap modes, polar snap, or filters for object snaps. The setting you make in this dialog box is saved to the Windows registry.

**Use Properties of Selected Object During Power Recall**
Sets the properties of the object created with Power Recall to those of the object you selected when you used Power Recall.

**Hide Operations: Turn Off Layers for 'Invisible' Objects**
Turns off layers for hidden objects.

**Preserve Online Translation Information**
Turns the Online Translation on. All AutoCAD Mechanical text strings inserted into the drawing are provided with internal information. You can then translate these text strings into another language, using the Language Converter.

**Extension of Center Lines Beyond Contour**
Sets a distance value at which centerlines are drawn extended beyond the selected edges.

**Administration Tools**
Saves registry entries to a configuration file (*.cfg) and sets administrative and high level configuration.

**Save to File**
Saves registry entries to a configuration file (*.cfg).
System
Displays the System Editor dialog box for administrative and high level configuration.

Automatic Update of Local Settings
Determines whether the network settings were made before the local settings and updates the local settings, if necessary.

Import
Displays the Open dialog box for selecting and importing a drawing file (*.dwg), a template drawing (*.dwt), a Genius 13/Genius 14 configuration file (*.cfg), or an AutoCAD Mechanical configuration file.

AMLAY
Organizes and manages the layer system

| Toolbutton | Layer Control |
| Menu       | Assist > Layer/Layergroup > Layer/Layer Group Control |
| Command    | AMLAY |

Use the AMLAY command to manage the layer system.

- Layer Control and Layer Group Control are combined in one dialog box.
- Layer names have been renamed and start with the prefix AM_*.
- It is possible to control the plot settings.
- Layer groups can be deleted in the dialog box.
- It is possible to assign objects to layer/layer groups.
- Layer and layer group options are available from the context (right-click) menu.
Use AMLIBRARY to manage your drawing files: that is, to add files, to
or remove files from the Library, and to insert files from the Library
into the current drawing.

All commands work with the Library are available from the context
(right-click) menu.

**Library Dialog Box**

**Folder section**
This section is on the left of the Library dialog box. It displays a list
of all the folders in the Library. When you select a folder, the folder
description appears below the folder section. To display a list of all
the files and subfolders contained in a folder, double-click the folder.

**Preview section**
This section is on the right of the Library dialog box. It displays slide
images of all drawing files located in the selected folder. When you
select a slide, it is highlighted, and the path description is displayed
in the area below the preview section. To insert a drawing into the
drawing window, double-click the desired slide.

**File context menu**
Open the file context menu by right-clicking on a file in the folder
section.

**Insert & Update ???**
Inserts the selected file into the drawing, using the scale factor and
rotation angle you specified in the Insert tab in the Options dialog
box.

**Options**
Displays the Add File dialog box, with the Insert tab.

**Edit**
Displays the Edit Drawing dialog box.
Delete  Displays the Delete File dialog box.

View  Displays a view of the selected drawing.

Slide  Creates a slide for the selected drawing.

**Folder context menu**
Open the folder context menu by right-clicking on a folder in the folder section.

Add from Drawing  Displays the Add from Drawing dialog box.

Add File  Displays the Add File dialog box.

Search  Displays the Search dialog box.

Create  Displays the Create Folder dialog box.

Options
Displays the Options dialog box, with the Insert and Misc tabs.

Edit  Displays the Edit Library dialog box.

Delete  Displays the Delete dialog box.

**AMOBJPURGE**

**Controls purge operations**

<table>
<thead>
<tr>
<th>Menu</th>
<th>File &gt; Drawing Utilities &gt; Purge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>AMOBJPURGE</td>
</tr>
</tbody>
</table>

Use AMOBJPURGE to clear the drawing of unused symbols (blocks, layers, linetypes, dimension styles, text styles, and multiline styles).
Purge Dialog Box

**Purge Unused**
Purges unused symbols.

**Blocks**
Purges unused blocks.

**Layers**
Purges unused layers.

**Dimension styles**
Purges unused dimension styles.

**Linetypes**
Purges unused linetypes.

**Text styles**
Purges unused text styles.

**Multiline styles**
Purges unused multiline styles.

**Info**
Displays the result of the purge.

**Options**
Selects the type of purge.

**Rename Xrefs**
Renames symbols of a bounded Xref before purging.

**Automatic Renaming During Xref Bind Operation**
Automatically renames symbols during the binding process of the Xref.

**Purge**
Starts the purge operation.
**AMSCMONITOR**

Views, edits, and monitors the scale of scale areas or viewports

- **Toolbutton**: ACAD/M Paper/Model Space
- **Menu**: View > Viewports > Scale Monitor
- **Command**: AMSCMONITOR

Use AMSCMONITOR to view, edit, and monitor the scale of scale areas or viewports.

Pick scale area to edit/Pick inside scale area to zoom/<Return> to finish:

*You can edit a view immediately by clicking in the view*

**Scale Monitor Dialog Box**

- **Scale**
  Displays the absolute scale of the area where the cursor is positioned.

- **Length Scaling**
  Displays the ratio between real size and drawn size.

- **Text Scaling**
  Displays the scaling factor for the symbol size.

**AMPOWERSNAP**

Configures the Power Snap settings

- **Toolbutton**: User Configuration
- **Menu**: Assist > Draft Settings > Power Snap Settings 1-4
- **Command**: AMPOWERSNAP

Use AMPOWERSNAP to set object snap modes, polar snap, and filters for object snaps. You can create five different settings for Power Snap to use globally.
Power Snap Settings Dialog Box

Current settings
Sets the selected object snap modes for the current drawing session. The tab selected previously becomes the Current Setting tab.

Setting 1 – Setting 4
Sets the selected object snap modes globally.

Snap Modes
Activates the desired snap modes.

Endpoint
Snaps to the closest endpoint of an object.

Midpoint
Snaps to the midpoint of an object.

Center
Snaps to the center of an arc, circle, ellipse, or elliptical arc.

Node
Snaps to a point object.

Quadrant
Snaps to a quadrant point of an arc or a circle.

Intersection
Snaps to the intersection of a line, an arc, or a circle.

Extension
Snaps to the phantom extension of an arc or a line.

Arc Radial Lines
Snaps to a point on the phantom line that passes through an arc center point and one of the arc endpoints.

Insertion
Snaps to the insertion point of text, a block, a shape, or an attribute.

Perpendicular
Snaps to a point perpendicular to an arc, a line, or a circle.

Tangent
Snaps to the tangent of an arc or a circle.

Nearest
Snaps to the nearest point of an arc, a circle, a line, or a point.

Apparent Int.
Snaps to the apparent intersection of two objects.
Parallel
Snaps parallel to a specified line.

Symmetry
Snaps symmetric to a specified line.

Arc Tangent Lines
Snaps to a point on the phantom line that passes tangentially through an arc endpoint.

Enable Object Snap
Activates the selected object snap modes on a setting tab.

Select All
Selects all object snap modes on the respective setting tab.

Clear All
Clears all selected object snap modes on the respective setting tab.

Polar Snap Setting
Displays the Polar Angle Settings dialog box.

Crosshair Size
Sets the size of the crosshairs.

Use Entity Filter
Activates the current settings in the Entity Filter dialog box.

Ignore Z Coordinate
Sets the Z coordinate to 0.0. All points you select are projected on the current coordinate system.

Use Coordinate Display
Displays the current cursor location as a coordinate on the status bar.

Show Snap in Status Line
Displays the current active snap modes on the status bar.

Filters
Displays the Entity Filter dialog box.
AMBOM

Opens the BOM database

Toolbutton       Edit BOM Database
Menu             Annotate > BOM Database
Command          AMBOM

Use AMBOM to create or edit a bill of material (BOM) database. The BOM database is a spreadsheet that lists all the parts and subassemblies in your assembly file in the order in which they were created or instanced in your drawing.

Bom table [Main] <Main>:  Select a BOM table

BOM Dialog Box

Print
Prints the current BOM.

Add Parts
Adds removed parts within the parts list.

Delete Column
Deletes the current column. A message requests confirmation. Item, Description, and Qty (Count) columns cannot be deleted.

Insert Column
Inserts a column in front of the current column and opens the BOM Properties dialog box. The new column is highlighted. Double-click the Column, Caption, and Width fields to edit the default values.

Add Item
Adds a row at the end of the database. Double-click the columns in the BOM dialog box to enter values.

Insert Item
Inserts a row above the current row. Double-click the columns in the BOM dialog box to enter values.

Delete Item
Deletes the current row. A message requests confirmation.

Merge Items
Merges two or more rows with the same data.

Split Item
Splits merged rows with a quantity greater than another.
Standard Properties
Opens the BOM Properties dialog box used to edit BOM, balloon, and parts list properties for the standards you are using in your drawing. See "AMSYMSTD".

Assembly Properties
Opens the Assembly Properties dialog box, used to add or change properties for the assemblies in your drawing.

BOM Representation
Opens the BOM Representation dialog box, which is used for controlling the appearance of external BOM tables (expanded and structured).

Sort
Specifies the sorting of the database.

Insert Parts List
Inserts a parts list into your drawing. See "AMPARTLIST".

Ballooning
Creates balloons in your drawing. See "AMBALLOON".

Export
Opens the Export dialog box. You can export data in a variety of formats.

Import
Opens the Import dialog box. You can import data in a variety of formats.

Set Values
Opens the Set Values dialog box, used to control the values for each column in the database.

Mask Editor
Starts the Mask Editor.
AMBALLOON

Creates and places balloons

Toolbutton Balloon
Menu Annotate > Parts List > Place Balloon
Command AMBALLOON

Use AMBALLOON to attach associative balloon callouts to part references in your drawing. You can control the display of balloons by modifying the symbol standards you have set in your drawing. Use AMSYMSTD to control symbol standards.

Select balloon’s operation:[Auto/Collect/Manual/One/Renumber]
<Auto>: Choose an option to create a balloon, or press ENTER

Collect
Creates a multiple balloon for selected part references.
Select pick object: Select the part references
Select pick object: Press ENTER
Select balloon: [New]: Enter n or select a balloon

Auto
Creates balloons for selected part references and aligns them horizontally or vertically.
Select pick object: Select part references
Select objects: Select additional part references, or press ENTER to continue
Align Standalone / Horizontal / <Vertical>: Specify the orientation, or press ENTER to place balloons

Manual
Creates a new part reference with a balloon.
Select point [Block / Copy / Reference]: Specify a point to place the new part reference
Select a start point of balloon: Specify a start point for the balloon leader
Next Point: Specify points for leader segments and press ENTER to the place balloon
One
Creates a single balloon.
Select pick object: Select a part reference
Select a start point of balloon: Specify a start point for the balloon leader
Next Point: Specify points for leader segments, and press ENTER to place the balloon.
Select another part reference or press ENTER to complete the procedure.

Renumber
Renumbers balloons in the drawing and changes item numbers in BOM.
Enter starting item number <1>: Enter the number for the first selected balloon.
Enter increment <1>: Enter the increment for the next selected balloon
Select one or more balloons. Selected balloons are renumbered.

AMDATUMID
Creates, adds, or updates a datum identifier symbol

<table>
<thead>
<tr>
<th>Toolbutton</th>
<th>Datum Identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>Annotate &gt; Symbols &gt; Datum Identifier</td>
</tr>
<tr>
<td>Command</td>
<td>AMDATUMID</td>
</tr>
</tbody>
</table>

Use AMDATUMID to create datum identifiers that conform to ANSI, BSI, DIN, ISO, JIS, CSN, and GB International Drafting Standards.
Start Point: Specify the insertion point of the symbol or the start point of the leader line
Next Point <Symbol>: Specify the next point of the leader line, or press ENTER to place the symbol
To place a symbol without a leader, press ENTER after you specify a start point.
Datum Identifier Dialog Box

Datum Value
Specifies the name of the datum identifier.

Arrowhead
Selects an arrowhead from the palette.

Amdatumtgt

Creates a datum target symbol

<table>
<thead>
<tr>
<th>Toolbutton</th>
<th>Datum Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>Annotate &gt; Symbols &gt; Datum Target</td>
</tr>
<tr>
<td>Command</td>
<td>AMDATUMTGT</td>
</tr>
</tbody>
</table>

Use AMDATUMTGT to place datum targets in your drawing. A datum establishes a theoretically exact plane, line, or profile.

Because all features are subject to deviation, it may be impractical to control the tolerance of an entire surface by using a datum. To specify practical datums, you select relevant locations called datum targets.

Datum target symbols conform to variations unique to ANSI, BSI, DIN, ISO, JIS, CSN, and GB International Drafting Standards.

You can place a datum target on a leader or attach one datum target to another. A datum target can be a point, a line, or an area.

Select a termination for the datum target. The prompts that appear depend on the selected termination type.

When you select Attach to Another as the termination type, select the datum target to which you want to attach the new datum target.

When you select None or Point as the termination type, the following prompts are displayed:

Select first point:  Specify the first point for the symbol leader
Next point:  Specify one or more points for the symbol leader, and press ENTER to open the Datum Target dialog box
When you select Line as the termination type, the following prompts are displayed:

First line point: Specify a point
Second line point: Specify a point
Next point: Specify one or more points for the symbol leader, and press ENTER to open the Datum Target dialog box

When you select Circle as the termination type, the following prompts are displayed:

Center point: Specify a point for the center of the circle termination.
Diameter / <Radius> <1>: Specify a radius of the circle termination, or enter d and specify a diameter, or press ENTER to accept the default radius
Next point: Specify one or more points for the symbol leader, and press ENTER to open the Datum Target dialog box

When you select Rectangle as the termination type, the following prompts are displayed:

Center point: Specify the center point of the rectangle termination
Corner: Specify a corner of the rectangle termination
Next point: Specify one or more points for the symbol leader, and press ENTER to open the Datum Target dialog box

**Termination Type Dialog Box**

Use this dialog box to specify the termination type for the datum target symbol.
The termination types are: Attached to Another, None, Point, Line, Circle, and Rectangle.

**Attached to Another**
Attaches the current datum target to an existing datum target, and opens the Datum Target dialog box.
Select Datum Target: Select an existing datum target

**None**
Creates a datum target without a special termination symbol, and opens the Datum Target dialog box.
Select first point: Specify a point
Next Point: Specify a point for another leader segment, or press ENTER.

**Point**
Creates a datum target symbol, using a point symbol as the termination type, and opens the Datum Target dialog box.
**Line**  
Creates a datum target to a line, and opens the Datum Target dialog box.

**Circle**  
Creates a datum target to a hatched circle, and opens the Datum Target dialog box.

**Rectangle**  
Creates a datum target to a hatched rectangle, and opens the Datum Target dialog box.

**Datum Target Dialog Box**

The Datum Target dialog box contains two tabs, Datum Target and Leader.

**Datum Target**

- **Dimension**  
  Specifies the dimension for the target area.

- **Datum**  
  Specifies the datum reference for the target.

**Leader Tab**

- **Linetype**  
  Toggles the leader linetype between solid and hidden.

- **Arrowhead**  
  Changes the leader arrowhead.

---

**AMFCFRAME**

creates, adds, or updates a feature control frame

**Toolbutton**  
Feature Control Frame

**Menu**  
Annotate > Symbols > Feature Control Frame

**Command**  
AMFCFRAME

Use AMFCFRAME to create feature control frames.

Feature control frames display geometric tolerances that show deviations of form, profile, orientation, location, and runout of a feature. All tolerance information for a single dimension is contained in the feature control frame.
Start Point:  Specify the insertion point of the frame or the start point of the leader line.
Next Point <Symbol>: Specify the next point of the leader line, or press ENTER to place the frame.

**Feature Control Frame Dialog Box**

**Frame tab**
The Frame tab contains settings and symbols for the feature control frame. You can attach two rows of modifiers to one feature control frame. By default, only one row is used.

At the bottom of the tab are buttons for facilitating numeric entry and applying modifiers and datum names.

- **Sym**
  Displays a palette of geometric symbols for straightness, cylindricity, angularity, position, symmetry, flatness, profile of a line, perpendicularity, concentricity, total runout, circularity, profile of a surface, parallelism, and circular runout.

- **Tolerance**
  Specifies the tolerance.

- **Datum**
  Specifies the datum value for the identification of the feature in the drawing.

- **Keyboard**
  Enters digits, signs, and letters to the tolerance data.

**Leader tab**
Controls leader segments, arrowhead styles, and all round symbols.

- **Segment / Leader**
  Adds or removes leader segments to or from the current feature control frame.

- **Arrowhead**
  Displays a palette of arrowhead styles for both primary and secondary leaders.

- **All Around Symbol**
  Specifies whether to place an all round symbol on the leader.
AMSURFSYM

**Creates a surface texture symbol**

<table>
<thead>
<tr>
<th>Toolbutton</th>
<th>Surface Texture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>Annotate &gt; Symbols &gt; Surface Texture</td>
</tr>
<tr>
<td>Command</td>
<td>AMSURFSYM</td>
</tr>
</tbody>
</table>

Use AMSURFSYM to create surface texture symbols that conform to ANSI, BSI, CSN, DIN, GB, ISO, and JIS Drafting Standards. DXF group codes are assigned to surface texture symbols and allow complete data exchange.

Surface texture symbols describe variations and tolerances of surface finish. The symbol controls minimum and maximum roughness, waviness, type of production method, and appearance or direction of tool marks.

**Start Point:** *Specify the insertion point of the symbol or the start point of the leader line*

**Next Point <Symbol>:** *Specify the next point of the leader line, or press ENTER to place the symbol*

**Rotation angle:** *Specify the rotation angle of the symbol, if you have specified the insertion point*

**Surface Texture Dialog Box**

**Symbol tab**

**Surface Type**

Specifies the type of surface referenced by the symbol.

- Basic surface
- Removal of material required
- Removal of material prohibited

**Miscellaneous**

Controls the display of the tail, majority symbol (JIS and ISO only), and round sign (ISO only) in the surface texture symbol.

**Surface Texture Symbol Modifiers**

Specifies additional values for the surface texture symbol.
### Leader tab

**Segment / Leader**
Adds or removes a leader segment or a leader node.

**Arrowhead**
Displays a palette of arrowhead styles.

**Symbol on the Leader**
Readjusts the position of the symbol on the leader.

### AMSYMLEADER

**Add or removes leaders from existing symbols**

<table>
<thead>
<tr>
<th>Toolbutton</th>
<th>Welding Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>Annotate &gt; Leader &gt; Append Leader</td>
</tr>
<tr>
<td>Command</td>
<td>AMSYMLEADER</td>
</tr>
</tbody>
</table>

Use AMSYMLEADER to attach or remove a leader from an existing symbol.

Enter an option [Add/Remove] <Add>: Choose an option or press ENTER

**Add**
Adds a leader to an existing symbol.

Select symbol to add leader: *Specify a symbol*
Select object to attach: *Specify an object to attach leader*
Start point: *Specify a start point*
Next point: Specify a second point or press ENTER

**Remove**
Removes a leader from an existing symbol.
Select leader node or leader segment: *Specify a leader*
Edits and defines drafting standards for symbols

Menu                  Annotate > Symbols > Symbol Standards
Command               AMSYMSTD

Use AMSYMSTD to specify the drafting standard to be applied to the symbols you create in the current drawing. You can define your own standard by changing a base International Standard.

Symbol Standard Dialog Box

The Symbol Standards dialog box controls the symbol standards defined in your drawing. A list shows the available standards. An open-book symbol preceding a standard indicates that it is the current standard.

Double-click a standard to make it the current standard. Click the plus sign in front of a standard to expand it. Click the plus sign in front of the standard’s categories to expand them. To access the symbol standard properties, right-click a standard or any of its categories, and choose Properties from the menu.

The following dialog boxes control symbol properties:

- The Standard Properties dialog box controls overall symbol properties.
- Surface Texture Properties determines the availability of surface texture options.
- Feature Control Frame Properties controls merging, end padding, geometric dimensioning, and tolerancing.
- Welding Properties determines the availability of welding symbol attributes.
- Datum Target Properties sets attributes such as linetypes, hatch size, and target point color.
• BOM Properties sets information such as column, caption, width, data type, size, precision, equivalents, caption alignment, and data alignment for a BOM spreadsheet.

• Balloon Properties sets attributes such as balloon style, arrow type, text height, color, and the columns to be displayed.

• Parts List Properties sets attributes such as insert heading, text color and height, frame color, row gap, lines of text, output direction, wrap text, and the columns to be displayed.

**NOTE** The current drafting standard determines the contents of the symbol properties dialog boxes. All options may not be available.

**Standard Properties Dialog Box**

The dialog box opens with settings that are specific to the current International Drafting Standard.

**Symbol**
Specifies the overall scale factor and color to use for the symbol.

**Text**
Controls the text style, height, and color used by text added to the symbol.

**Leader**
Controls the arrowhead style, size, and color for the symbol.

**Modify**
Provides access to the dialog boxes used to change the properties for the surface texture, feature control frame, welding, datum target, and BOM and Balloon symbols.

**Default**
Sets all values back to the default defined by the current standard.
Surface Texture Properties Dialog Box

Revision
Displays the current standard.

Symbol
Sets the size of the Machining Prohibited designation.

All Round
Sets the all round designation on symbols.

Multiline
Sets the use of multiline symbols.

Force Tail
Forces a tail on the symbol.

The Direction of Machining Lay
Controls machining lay specifications.

Feature Control Frame Properties Dialog Box

Revision
Displays the current standard.

Merge
Sets the following merging options:
- Removes duplicate tolerance types.
- Removes duplicate tolerance zones.
- Removes duplicate of merge datum references.

End Padding
Sets spacing to align similar zones.

Geometric Dimensioning and Tolerancing
Sets the types of available symbols.
Show Symbols for
Sets the symbols to be displayed. Select a type from the list, and select the control symbols in the window. Available types are

- Geometric Characteristic
- Material Removal Modifier

Style
Sets the text style for symbols.

Default
Returns all values to the default values for the current standard.

Welding Properties Dialog Box

Revision
Displays the current standard.

Identification Line
Sets the linetype to use for identification lines.

Gap
Sets the gap distance between the identification line and the reference line.

Weld Symbols
Specifies the weld symbols to use.

Show Symbols for
Sets the symbols to be displayed. Select a type from the list, and select the control symbols in the window. Available types are

- Weld Symbols
- Contour Symbols
- Backing Symbols

Default
Returns all values to the default values for the current standard.
Datum Target Properties Dialog Box

Revision
Displays the current standard.

Target Point
Sets the size and color of the target point.

Area Hatch
Sets the distance between the hatch lines and the hatch angle.

Draw Arrowheads
Specifies whether arrowheads are drawn when the symbol is created.

Hidden Leader Linetype
Specifies the linetype to use for hidden leaders.

Boundary Linetype
Specifies the linetype to use for the datum target boundary.

Default
Returns all values to the default values for the current standard.

BOM Properties Dialog Box

Revision
Displays the current standard.

Column
Lists the columns defined in the Bill of Material database. Column names in red cannot be modified, as they are used internally by AMBOM. To modify other column names, double-click in the field and enter a new value.

Caption
Lists the caption used by AMBOM for each column, when a parts list is created. To modify a caption, double-click in the field, and enter a new value.

Width
Lists the width of each column used by AMBOM, when a parts list is created. To modify a width, double-click in the field, and enter a new value.

Equivalents
Lists the equivalent variable names for columns. Double-click to edit.
**Data Type**
Specifies the data type for the selected column. Data types are text, integer, and real.

**Size**
Sets the maximum character size for the data in the selected column.

**Precision**
Sets the precision for the data in the selected column. Available only if the data type is real.

**Caption Alignment**
Specifies the alignment for the caption in each column of the parts list.

**Data Alignment**
Specifies the alignment for the data in each column of the parts list.

**Modify**
Provides access to the Balloon Properties and Standard Properties dialog boxes.

**Default**
Returns all values to the default values for the current standard.

---

**Print Setup Dialog Box**

**Margins**
Sets values for the printer margins, and specifies whether the parts list is centered on the page.

**Print**
Specifies whether captions and headings are printed.

**Fonts Tab**
Controls the fonts to use for the title, heading, and body of the parts list.

**Line Tab**
Controls the line thicknesses to use in the parts list.

**Printer**
Opens the Windows Print Setup dialog box.

**Preview**
Opens the Preview dialog box.

**Default**
Returns all values to the default values for the current standard.
Preview Dialog Box

**Previous**
Displays the previous parts list, if more than one exists in the current drawing.

**Next**
Displays the next parts list, if more than one exists in the current drawing.

**Close**
Closes the dialog box.

AMWELDSYM

**Creates a welding symbol**

<table>
<thead>
<tr>
<th>Toolbutton</th>
<th>Welding Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>Annotate &gt; Symbols &gt; Welding</td>
</tr>
<tr>
<td>Command</td>
<td>AMWELDSYM</td>
</tr>
</tbody>
</table>

Use AMWELDSYM to create welding symbols that conform to international drafting standards. DXF group codes are assigned to welding symbols and allow complete data exchange.

Start Point: *Specify a start point for the leader*

Next Point <Symbol>: *Specify an endpoint for the leader*

Next Point <Symbol>: *Specify a point for another leader segment, or press ENTER*
Weld Symbol Dialog Box

The Weld Symbol dialog box controls the settings for welding symbols. The dialog box contains four tabs: General, Arrow Side, Other Side, and Leader.

**General tab**

**Orientation**
Controls the location and orientation (left or right) of the welding symbol.

**Stagger**
Offsets dual fillet welds to indicate staggered welds. This option is available only when fillet welds are applied to both sides of the symbol.

**Symbol**
Controls the number of reference lines added to the symbol.

**Additional Controls**
In the lower section of the General tab, you can add a tail, a field weld symbol, an all round symbol, and notes for the weld symbol. You can also set the symbols to use on either side of the arrow. Hold your cursor over an area, and wait for the tooltip to be displayed, for a description.

**Arrow Side Tab**
The contents of this tab vary, depending on the type of weld you have specified. Specify values for the fields that apply.

**Other Side Tab**
The contents of this tab vary, depending on the type of weld you have specified. Specify values for the fields that apply.

**Leader Tab**

**Segment/Leader**
Controls the addition and removal of leader segments.

**Arrowhead**
Displays a palette of arrowhead styles.
Experienced with AutoCAD Mechanical 14.x

This chapter contains information about changes and a listing of revised commands for ACAD/M 14.x user.

- General Changes
- Migrating AutoCAD Mechanical 14 Drawings to AutoCAD Mechanical 2000
- New and Revised Commands
General Changes

If you are an AutoCAD Mechanical 14 user, the first thing you'll notice about AutoCAD Mechanical 2000 is that we've been busy making a lot of productivity enhancing changes. For your convenience, we've assembled a list of those changes and other helpful information so that you can get started in this version of AutoCAD Mechanical right away.

Integrated Genius Functionality

AutoCAD Mechanical 2000 and the AutoCAD Mechanical 2000 Power Pack include the complete functionality of three Genius products previously sold separately: Genius 14, Genius Profile, and Vario Runtime. This functionality has been combined with the AutoCAD Mechanical 14 functionality and added to the familiar AutoCAD Mechanical user interface.

Issuing Commands

There are four ways to invoke AutoCAD Mechanical commands: from a menu, from a toolbar, from the AutoCAD Mechanical Tablet, or from the command line. If you choose to execute a command from the command line, be aware that all AutoCAD Mechanical 2000 commands start with AM. For example, AMHOLECHART, to create hole charts.

Chapter 2 If you are New to AutoCAD Mechanical lists all AutoCAD Mechanical commands in alphabetical order separated in commands for AutoCAD Mechanical on page 15 and the AutoCAD Mechanical Power Pack Package on page 28.
Menu and Toolbar Changes

AutoCAD Mechanical 2000 incorporates the new functionality of this release in the familiar AutoCAD Mechanical 14 streamlined mechanical menu structure. Besides a large influx of new functionality, the menu structure remains largely intact from previous versions. There have been some significant changes to the toolbars, to accommodate the new functionality.

As the default, AutoCAD Mechanical 2000 starts with an express toolbar set up at the left side. This includes design, assistance, annotation, and content commands. AutoCAD Mechanical 2000 also includes other preset toolbar configurations. Use AMTBLEFT, AMTBRIGHT, and AMTBFULL (you can find these under View > Toolbars) to use the other presets toolbar configuration.

Migrating AutoCAD Mechanical 14 Drawings

AutoCAD Mechanical 2000 uses a newer drawing format than AutoCAD Mechanical 14. You can open any drawing created with a previous version of AutoCAD Mechanical. However, AutoCAD Mechanical 2000 files cannot directly be read by previous versions.

You can to save your AutoCAD Mechanical 2000 drawings in AutoCAD Release 14 format. However, some of the new, intelligent objects will be stored as proxy objects.
New and Revised Commands

AutoCAD Mechanical 2000 includes over 140 new commands from the previous version. The AutoCAD Mechanical 2000 Power Pack includes over 60 additional commands. Because there have been so many new enhancements to AutoCAD Mechanical, it is recommended that you read Chapter 2 If You are New to AutoCAD Mechanical.

In this chapter you will find an overview of the features and functionality of AutoCAD Mechanical 2000 and AutoCAD Mechanical 2000 Power Pack as well as a command summary for each command in these products.
Use this appendix as a guide to help you get acquainted with AutoCAD Mechanical’s toolbar icons.
Main Toolbar

Main Toolbar ▶ New

Main Toolbar ▶ Basic Layer
Main Toolbar ▶ EX Layer Functions

- Layer Control
- Layer Group Control
- Visibility Enhancements
- Move to Another Layer
- Move to Another Layer Group
- Make Objects Layer Current
- Edit Lines On/Off
- Pointer On/Off
- Invisible Lines On/Off

Main Toolbar ▶ Inquiry

- List
- Locatable Point
- Distance
- Mass
- Calculator

Main Toolbar ▶ Undo

- Undo
- Redo

Main Toolbar ▶ Library

- Library
- Link
- Hyperlink
Main Toolbar  ▶ Power Edit

- Power Edit
- Object Properties
- Hatch
- Plot
- Edit Spline
- Edit Reference

Main Toolbar  ▶ Power Erase

- Power Erase
- Erase
- OOPS

Main Toolbar  ▶ Power Dimensioning

- Power Dimensioning
- Automatic Dimensioning
- Dimension Angle
- Hole Charts
- Fillet List
- Multi Edit
- Arrange Dimension
- Stretch Dimension
- Align Dimensions
- Join Dimensions
- Insert Dimensions
- Break Dimension
- AUTOCAD Units

Main Toolbar  ▶ Power Dimensioning  ▶ Units

- Units 1 Decimal Place
- Units 2 Decimal Place
- Units 3 Decimal Place
- Unit 4 Decimal Place
- Unit 5
Main Toolbar ➤ Power Snap

User Configuration
User Configuration 1
User Configuration 2
User Configuration 3
User Configuration 4

Main Toolbar ➤ Compass Rose

Relative Point
Rel. Ang. 0 deg.
Rel. Ang. 45 deg.
Rel. Ang. 90 deg.
Rel. Ang. 135 deg.
Rel. Ang. 180 deg.
Rel. Ang. 225 deg.
Rel. Ang. 270 deg.
Rel. Ang. 315 deg.

Main Toolbar ➤ UCS

UCS
Named UCS
Preset UCS
UCS Previous
World UCS
Object UCS
Face UCS
View UCS
Origin UCS
Z-Axis Vector UCS
3 Point UCS
X-Axis Rotated UCS
Y-Axis Rotated UCS
Z-Axis Rotated UCS
Apply UCS
**Zoom Toolbar**

- Zoom Toolbar ➤ Zoom

- Zoom Toolbar ➤ Zoom 2

**Design Toolbar**

- Design Toolbar

---

110 | Appendix A  Toolbar Icons
Design Toolbar ▶ Draw

Design Toolbar ▶ Draw ▶ Line

Design Toolbar ▶ Draw ▶ Arc
Design Toolbar  ▶ Draw  ▶ Rectangle

- Rectangle
- Rectangle basepoint, width, height
- Rectangle, center base, 3 Point
- Rectangle center base, width, height
- Rectangle center base, width/2, height
- Rectangle, center left, 2 Point
- Rectangle center left, width, height
- Rectangle center left, width, height/2
- Quadrant, center, 2 Point
- Rectangle, center, width, height
- Rectangle, center, width, height/2
- Rectangle, center, width/2, height
- Quadrant, left base, right base
- Quadrant, center base, right base
- Quadrant, center left, upper left
- Quadrant, center, center right
- Quadrant, center base, center top
- Quadrant, center left, center right
- Quadrant, center, width

Design Toolbar  ▶ Draw  ▶ Circle

- Circle, Center, Radius
- Circle, Center, Diameter
- Circle, 2 Points
- Circle, 3 Points
- Circle, T, T, R (Tangent, Tangent, Radius)
- Ellipse
- Donut
Design Toolbar  ▶  Draw  ▶  Centerlines

- Centerlines
- Centerline, Cross
- Centerline, Cross with Hole
- Centerline Cross in Center
- Centerline Cross on Perp
- Centerline Cross on Full Circle
- Centerline Cross with Angles
- Centerline Cross in Hole
- Centerline in between

Design Toolbar  ▶  Draw  ▶  Hatch

- Hatch 45 deg, 0.5mm/0.0inch
- Hatch 45 deg, 0.5mm/0.22inch
- Hatch 45 deg, 1.0mm/0.0inch
- Hatch 135 deg, 0.7mm/0.12inch
- Hatch 135 deg, 1.77mm/0.14inch
- Hatch 135 deg, 0.1mm/0.0inch
- User-Defined Hatch
- Double Hatch 45 deg, 2.0mm/0.0inch
Design Toolbar  ▶  Draw  ▶  Construction Line

- Horizontal
- Vertical
- Grass
- 2 Direction
- 2 Points or Angle
- Relative Angle from Line
- Parallel with Full Distance
- Parallel with Half Distance
- Perpendicular to 2 Points
- Perpendicular to Line
- Bisect
- Tangent
- 2-circle Tangent
- Concentric Circle
- Create Circle to end of Shaft
- Circle Tangent to Line
- Circle Tangent to 2 Lines
- Rectangle on Circle
- Circle
- Ray, at Point
- Lines of Point

Design Toolbar  ▶  Draw  ▶  Construction Edit

- Erase C-Lines
- Switch Ray/Paths
- Erase all C-Lines
- C-Lines Lock/Unlock
- Projection On/Off
- Automatic C-Line Creation
- Trace Contour
- Hide Contours Visible
Design Toolbar ▶ Modify

Design Toolbar ▶ Modify ▶ Copy
- Copy
- Copy+Mirror
- Copy+Rotate+Move

Design Toolbar ▶ Modify ▶ 2D Operations
- Mirror
- Array

Design Toolbar ▶ Modify ▶ Break
- Break
- Break at 1 Point
- Select and Break

Design Toolbar ▶ Modify ▶ Divide
- Divide
- Measure

Design Toolbar ▶ Modify ▶ Stretch
- Stretch
- Scale X,Y
- Scale
Design Toolbar  ▸  2D Hide

Design Toolbar  ▸  XREF

Assistance Toolbar

Assistance Toolbar  ▸  Block Create
Assistance Toolbar  ▶ XREF Block Insert

Assistance Toolbar  ▶ EX Title Block

Assistance Toolbar  ▶ EX Text

Assistance  ▶ Modelspace/Layout
**Annotation Toolbar**

- **Annotation Toolbar** → **Symbols**
- **Annotation Toolbar** → **Leader**
- **Annotation Toolbar** → **BOM**

**Content Toolbar**

- **Content Toolbar**
- **ACAD. SYMBOLES**
- **ACAD. LEADER**
- **ACAD. BOM**
- **ACAD. USER HOLES**
- **ACAD. STD TOOLS**
- **ACAD. CAM PLATES**
- **ACAD. CALCULATIONS**
Power Snap Toolbar

Power Snap Toolbar ➤ Point Filters

| X | Y | XY | Z | ZX | YZ |
Power Pack Content Toolbar

This toolbar is only accessible if you have installed the Power Pack.

PP Content ▶ Screw Connection

PP Content ▶ Holes

PP Content ▶ Shaft Generator
PP Content  ▶  Standard Tools

PP Content  ▶  Standard Parts

PP Content  ▶  PP Calculation

PP Content  ▶  Cam Plates

122 | Appendix A  Toolbar Icons
PP Content ▸ Chain / Belt Calculations

- Draw Sprocket/Pulley
- Length Calculation
- Draw Chain/Belt Links
Accelerator Keys

Use this appendix as a guide to help you get acquainted with AutoCAD Mechanical’s accelerator keys.
Using Accelerator Keys

Many frequently used commands are accessible using automated shortcuts known as accelerator keys. Accelerator keys are available for AutoCAD as well as for AutoCAD Mechanical.

**WARNING!** Accelerator keys are automatically loaded when you install AutoCAD Mechanical 2000. Accelerator keys specific to AutoCAD Mechanical 2000 are appended at the end of the acad.pgp file. If you have created custom accelerator keys with the same letter combinations as those in the following table, they will be superseded because the last entry in the file is activated by the keystrokes. To restore your custom accelerator keys, move the definition to the end of the acad.pgp file.

To use an accelerator key to start a command

1. On the command line, enter the key(s) that correspond to the command you want to use.
2. Press ENTER, the spacebar, or the right mouse button to execute the command.

### Accelerator keys available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>bal</td>
<td>Place Balloon</td>
<td>AMBALLOON</td>
</tr>
<tr>
<td>cb</td>
<td>Centerline Cross with Hole</td>
<td>AMCENCROSSHOLE</td>
</tr>
<tr>
<td>cha</td>
<td>Chamfer</td>
<td>AMCHAM</td>
</tr>
<tr>
<td>cl</td>
<td>Centerline</td>
<td>AMCENTLINE</td>
</tr>
<tr>
<td>clin</td>
<td>Draw C-Lines</td>
<td>AMCONSTLINES</td>
</tr>
<tr>
<td>cloo</td>
<td>C-Lines ON/OFF</td>
<td>AMCLINEO</td>
</tr>
<tr>
<td>cr</td>
<td>Copy+Rotate+Move</td>
<td>AMCOPYRM</td>
</tr>
<tr>
<td>cs</td>
<td>Centerline Cross</td>
<td>AMCENCROSS</td>
</tr>
<tr>
<td>dan</td>
<td>Angle Dimensioning</td>
<td>AMPOWERDIM_ANG</td>
</tr>
</tbody>
</table>
## Accelerator keys available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>dau</td>
<td>Automatic Dimensioning</td>
<td>AMAUTODIM</td>
</tr>
<tr>
<td>dmed</td>
<td>Multi Edit</td>
<td>AMDIMMEDIT</td>
</tr>
<tr>
<td>f</td>
<td>Fillet</td>
<td>AMFILLET2D</td>
</tr>
<tr>
<td>h</td>
<td>User Defined Hatch</td>
<td>AMUSERHATCH</td>
</tr>
<tr>
<td>hioo</td>
<td>Invisible Lines On/Off</td>
<td>AMLAYINVO</td>
</tr>
<tr>
<td>l0</td>
<td>Layer AM_0</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l1</td>
<td>Layer AM_1</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l2</td>
<td>Layer AM_2</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l3</td>
<td>Layer AM_3</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l3n</td>
<td>Layer AM_3N</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l4</td>
<td>Layer AM_4</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l5</td>
<td>Layer AM_5</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l6</td>
<td>Layer AM_6</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l7</td>
<td>Layer AM_7</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l7n</td>
<td>Layer AM_7N</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l8</td>
<td>Layer AM_8</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l9</td>
<td>Layer AM_9</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l10</td>
<td>Layer AM_10</td>
<td>AMLAY</td>
</tr>
<tr>
<td>l11</td>
<td>Layer AM_11</td>
<td>AMLAY</td>
</tr>
<tr>
<td>lib</td>
<td>Library</td>
<td>AMLIBRARY</td>
</tr>
<tr>
<td>lg</td>
<td>Layer/Layer Group Control</td>
<td>AMLAY</td>
</tr>
<tr>
<td>Key</td>
<td>Function</td>
<td>COMMAND</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>lgmo</td>
<td>Move to another Layer Group</td>
<td>AMLGMOVE</td>
</tr>
<tr>
<td>lgv</td>
<td>Layer Group Visibility</td>
<td>AMLAYVISENH</td>
</tr>
<tr>
<td>lmo</td>
<td>Move to another Layer</td>
<td>AMLAYMOVE</td>
</tr>
<tr>
<td>o</td>
<td>Offset</td>
<td>AMOFFSET</td>
</tr>
<tr>
<td>oo</td>
<td>Offset</td>
<td>3DORBIT</td>
</tr>
<tr>
<td>par</td>
<td>Create Part Reference</td>
<td>AMPARTREF</td>
</tr>
<tr>
<td>pc</td>
<td>Power Copy</td>
<td>AMPOWERCOPY</td>
</tr>
<tr>
<td>pd</td>
<td>Power Dimensioning</td>
<td>AMPOWERDIM</td>
</tr>
<tr>
<td>ped</td>
<td>Power Edit</td>
<td>AMPOWEREDIT</td>
</tr>
<tr>
<td>per</td>
<td>Power Erase</td>
<td>AMPOWERERASE</td>
</tr>
<tr>
<td>prc</td>
<td>Power Recall</td>
<td>AMPOWERRECALL</td>
</tr>
<tr>
<td>proo</td>
<td>Part Reference Layer On/Off</td>
<td>AMLAYPARTREFO</td>
</tr>
<tr>
<td>pss</td>
<td>Power Snap Settings 1 - 4</td>
<td>AMPOWERSNAP</td>
</tr>
<tr>
<td>rec</td>
<td>Rectangle</td>
<td>AMRECTANG</td>
</tr>
<tr>
<td>s1</td>
<td>Power Snap Settings 1</td>
<td>AMPSNAP1</td>
</tr>
<tr>
<td>s2</td>
<td>Power Snap Settings 2</td>
<td>AMPSNAP2</td>
</tr>
<tr>
<td>s3</td>
<td>Power Snap Settings 3</td>
<td>AMPSNAP3</td>
</tr>
<tr>
<td>s4</td>
<td>Power Snap Settings 4</td>
<td>AMPSNAP4</td>
</tr>
<tr>
<td>sm</td>
<td>Scale Monitor</td>
<td>AMSCMONITOR</td>
</tr>
<tr>
<td>stoo</td>
<td>Standard parts Layer ON/OFF.</td>
<td>AMLAYPARTO</td>
</tr>
<tr>
<td>tioo</td>
<td>Title block Layer on/off</td>
<td>AMLAYTIBLO</td>
</tr>
<tr>
<td>txl</td>
<td>Language Converter</td>
<td>AMLANGCONV</td>
</tr>
<tr>
<td>Key</td>
<td>Function</td>
<td>COMMAND</td>
</tr>
<tr>
<td>-----</td>
<td>--------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>u0</td>
<td>Units 0</td>
<td></td>
</tr>
<tr>
<td>u1</td>
<td>Units 1</td>
<td></td>
</tr>
<tr>
<td>u2</td>
<td>Units 2</td>
<td></td>
</tr>
<tr>
<td>u3</td>
<td>Units 3</td>
<td></td>
</tr>
<tr>
<td>u4</td>
<td>Units 4</td>
<td></td>
</tr>
<tr>
<td>v1</td>
<td>Upper left</td>
<td>AMVIEWUL</td>
</tr>
<tr>
<td>v2</td>
<td>Upper right</td>
<td>AMVIEWUR</td>
</tr>
<tr>
<td>v3</td>
<td>Lower left</td>
<td>AMVIEWLL</td>
</tr>
<tr>
<td>v4</td>
<td>Lower right</td>
<td>AMVIEWLR</td>
</tr>
<tr>
<td>v5</td>
<td>Center</td>
<td>AMVIEWCEN</td>
</tr>
<tr>
<td>va</td>
<td>View al</td>
<td>AMVIEWALL</td>
</tr>
<tr>
<td>vp0</td>
<td>Viewport Layer on/off</td>
<td>AMLAYVPO</td>
</tr>
</tbody>
</table>
Tablet Commands

Use this appendix as a guide to help you get acquainted with AutoCAD Mechanical’s tablet commands.
Using Tablet Commands

With AutoCAD Mechanical 2000, you are also able to work with a tablet. This is another easy way to start commands. You can configure your tablet using the AMTABLET command (for detailed information, see the Online Help).

To use a tablet to start a command
1 Click the tablet at the specified position.

Table Area I

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>A 1</td>
<td>QUIT</td>
<td>QUIT</td>
</tr>
<tr>
<td>A 2</td>
<td>NEW</td>
<td>NEW</td>
</tr>
<tr>
<td>A 3</td>
<td>OPEN</td>
<td>OPEN</td>
</tr>
<tr>
<td>A 4</td>
<td>SAVE</td>
<td>QSAVE</td>
</tr>
<tr>
<td>A 5</td>
<td>END</td>
<td>END</td>
</tr>
<tr>
<td>A 7</td>
<td>OBJPROP</td>
<td>PROPERTIES</td>
</tr>
<tr>
<td>A 8</td>
<td>MATCHPROP</td>
<td>MATCHPROP</td>
</tr>
<tr>
<td>A 9</td>
<td>MEASURE</td>
<td>MEASURE</td>
</tr>
<tr>
<td>A 10</td>
<td>DIVIDE</td>
<td>DIVIDE</td>
</tr>
<tr>
<td>A 11</td>
<td>ARRAY</td>
<td>ARRAY</td>
</tr>
<tr>
<td>B 7</td>
<td>HIDE</td>
<td>AM2DHIDE</td>
</tr>
<tr>
<td>B 8</td>
<td>EDIT</td>
<td>AM2DHIDEDIT</td>
</tr>
<tr>
<td>B 9</td>
<td>JOIN</td>
<td>AMJOIN</td>
</tr>
<tr>
<td>B 10</td>
<td>CHAMFER</td>
<td>AMCHAM2D</td>
</tr>
</tbody>
</table>
### Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>B 11</td>
<td>FILLET</td>
<td>AMFILLET2D</td>
</tr>
<tr>
<td>C 1</td>
<td>REDO</td>
<td>REDO</td>
</tr>
<tr>
<td>C 2</td>
<td>UNDO</td>
<td>UNDO</td>
</tr>
<tr>
<td>C 3</td>
<td>BEGIN</td>
<td>UNDO</td>
</tr>
<tr>
<td>C 4</td>
<td>END</td>
<td>UNDO</td>
</tr>
<tr>
<td>C 5</td>
<td>U</td>
<td>U</td>
</tr>
<tr>
<td>C 7</td>
<td>ALIGN</td>
<td>ALIGN</td>
</tr>
<tr>
<td>C 8</td>
<td>MIRROR</td>
<td>MIRROR</td>
</tr>
<tr>
<td>C 9</td>
<td>BREAK 3P</td>
<td>BREAK</td>
</tr>
<tr>
<td>C 10</td>
<td>BREAK 2P</td>
<td>BREAK</td>
</tr>
<tr>
<td>C 11</td>
<td>BREAK 1P</td>
<td>AMBREAKATPT</td>
</tr>
<tr>
<td>D 7</td>
<td>STRETCH</td>
<td>STRETCH</td>
</tr>
<tr>
<td>D 8</td>
<td>SCALE X&lt;&gt;Y</td>
<td>AMSCALEXY</td>
</tr>
<tr>
<td>D 9</td>
<td>SCALE X=Y</td>
<td>SCALE</td>
</tr>
<tr>
<td>D 10</td>
<td>EXTEND</td>
<td>EXTEND</td>
</tr>
<tr>
<td>D 11</td>
<td>TRIM</td>
<td>TRIM</td>
</tr>
<tr>
<td>E 1</td>
<td>SELECT</td>
<td>QSELECT</td>
</tr>
<tr>
<td>E 2</td>
<td>FILTER</td>
<td>FILTER</td>
</tr>
<tr>
<td>E 3</td>
<td>GROUP</td>
<td>GROUP</td>
</tr>
<tr>
<td>E 5</td>
<td>ALL</td>
<td>ALL</td>
</tr>
<tr>
<td>E 7</td>
<td>OFFSET</td>
<td>AMOFFSET</td>
</tr>
<tr>
<td>E 8</td>
<td>ROTATE</td>
<td>ROTATE</td>
</tr>
</tbody>
</table>
## Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>E 9</td>
<td>COPY+ROT+MOVE</td>
<td>AMCOPYRM</td>
</tr>
<tr>
<td>E 1</td>
<td>COPY</td>
<td>COPY</td>
</tr>
<tr>
<td>E 11</td>
<td>COPY M</td>
<td>AMCOPYM</td>
</tr>
<tr>
<td>F 1</td>
<td>ADD M</td>
<td>ADD</td>
</tr>
<tr>
<td>F 2</td>
<td>REMOVE</td>
<td>REM</td>
</tr>
<tr>
<td>F 3</td>
<td>FENCE</td>
<td>FE</td>
</tr>
<tr>
<td>F 4</td>
<td>CP</td>
<td>CP</td>
</tr>
<tr>
<td>F 5</td>
<td>WP</td>
<td>WP</td>
</tr>
<tr>
<td>F 7</td>
<td>LENGTHEN</td>
<td>LENGTHEN</td>
</tr>
<tr>
<td>F 8</td>
<td>OOPS</td>
<td>OOPS</td>
</tr>
<tr>
<td>F 9</td>
<td>ERASE</td>
<td>ERASE</td>
</tr>
<tr>
<td>F 10</td>
<td>ERASE L</td>
<td>ERASE</td>
</tr>
<tr>
<td>F 11</td>
<td>MOVE</td>
<td>MOVE</td>
</tr>
<tr>
<td>G 1</td>
<td>UNDO</td>
<td>U</td>
</tr>
<tr>
<td>G 2</td>
<td>PREV</td>
<td>PRE</td>
</tr>
<tr>
<td>G 3</td>
<td>LAST</td>
<td>LAS</td>
</tr>
<tr>
<td>G 4</td>
<td>CROSS</td>
<td>CRO</td>
</tr>
<tr>
<td>G 5</td>
<td>WINDOW</td>
<td>WIN</td>
</tr>
<tr>
<td>H 7</td>
<td>CONFIG</td>
<td>AMPOWERSNAP;</td>
</tr>
<tr>
<td>H 8</td>
<td>CONFIG 1</td>
<td>AMPSNAP1</td>
</tr>
<tr>
<td>H 9</td>
<td>CONFIG 2</td>
<td>AMPSNAP2</td>
</tr>
<tr>
<td>H 10</td>
<td>CONFIG 3</td>
<td>AMPSNAP3</td>
</tr>
</tbody>
</table>
# Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>H 11</td>
<td>CONFIG 4</td>
<td>AMPSNAP4</td>
</tr>
<tr>
<td>I 1</td>
<td>C-LINE</td>
<td>AMCLINEO</td>
</tr>
<tr>
<td>I 2</td>
<td>MOVE TO</td>
<td>AMLAYMOVE</td>
</tr>
<tr>
<td>I 4</td>
<td>SECTION</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>I 5</td>
<td>CONTOUR</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>I 7</td>
<td>SNAP SETTINGS</td>
<td>DSETTINGS 2</td>
</tr>
<tr>
<td>I 8</td>
<td>Z ON/OFF</td>
<td>AMPSNAPZO</td>
</tr>
<tr>
<td>I 9</td>
<td>TRACKING</td>
<td>TT</td>
</tr>
<tr>
<td>I 10</td>
<td>EXTENSION</td>
<td>EXT</td>
</tr>
<tr>
<td>I 11</td>
<td>PARALLEL</td>
<td>PAR</td>
</tr>
<tr>
<td>J 1</td>
<td>HIDDEN</td>
<td>AMLAYINVO</td>
</tr>
<tr>
<td>J 4</td>
<td>PHANTOM</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>J 5</td>
<td>CONTOUR</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>J 8</td>
<td>PER</td>
<td>PER</td>
</tr>
<tr>
<td>J 9</td>
<td>MID</td>
<td>MID</td>
</tr>
<tr>
<td>J 10</td>
<td>END</td>
<td>END</td>
</tr>
<tr>
<td>J 11</td>
<td>INT</td>
<td>INT</td>
</tr>
<tr>
<td>K 1</td>
<td>PARTREF</td>
<td>AMLAYPARTREFO</td>
</tr>
<tr>
<td>K 2</td>
<td>DDLMODES</td>
<td>LAYER</td>
</tr>
<tr>
<td>K 5</td>
<td>CONTOUR</td>
<td>AMLAYER_CON3</td>
</tr>
<tr>
<td>K 7</td>
<td>FILTER ON/OFF</td>
<td>AMPSNAPFILTERO</td>
</tr>
<tr>
<td>K 8</td>
<td>3D INT</td>
<td>APPINT</td>
</tr>
<tr>
<td>Tablet</td>
<td>Function</td>
<td>COMMAND</td>
</tr>
<tr>
<td>--------</td>
<td>------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>K 9</td>
<td>INSERT</td>
<td>INS</td>
</tr>
<tr>
<td>K 10</td>
<td>TANGENT</td>
<td>TAN</td>
</tr>
<tr>
<td>K 11</td>
<td>CENTER</td>
<td>CEN</td>
</tr>
<tr>
<td>L 1</td>
<td>VIEWPORT</td>
<td>AMLAYVPO</td>
</tr>
<tr>
<td>L 4</td>
<td>HIDDEN NARROW</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>L 5</td>
<td>HIDDEN WIDE</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>L 7</td>
<td>Rectangle Center</td>
<td>AMPSNAPCEN</td>
</tr>
<tr>
<td>L 8</td>
<td>NONE</td>
<td>NON</td>
</tr>
<tr>
<td>L 9</td>
<td>POINT</td>
<td>NOD</td>
</tr>
<tr>
<td>L 10</td>
<td>QUADRANT</td>
<td>QUA</td>
</tr>
<tr>
<td>L 11</td>
<td>NEXT</td>
<td>NEA</td>
</tr>
<tr>
<td>M 1</td>
<td>BASE&gt;STAND</td>
<td>AMLAYMOVEPL</td>
</tr>
<tr>
<td>M 2</td>
<td>MOVE TO</td>
<td>AMLGMOVE</td>
</tr>
<tr>
<td>M 5</td>
<td>HELP LINE</td>
<td>AMLAYER_HLIN</td>
</tr>
<tr>
<td>M 7</td>
<td>CENTER 2PT</td>
<td>AMPSNAPMID</td>
</tr>
<tr>
<td>M 10</td>
<td>VIRT INTERS</td>
<td>AMPSNAPVINT</td>
</tr>
<tr>
<td>M 11</td>
<td>REFERENCE FROM</td>
<td>AMPSNAPREF</td>
</tr>
<tr>
<td>N 1</td>
<td>STAND-&gt;BASE</td>
<td>AMLAYMOVEWL</td>
</tr>
<tr>
<td>N 2</td>
<td>LYGROUP</td>
<td>AMLG</td>
</tr>
<tr>
<td>N 5</td>
<td>DIM LINE</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>O 1</td>
<td>PARTS ON</td>
<td>AMLAYPARTO</td>
</tr>
<tr>
<td>O 2</td>
<td>VISIBLE</td>
<td>AMLAYVISENH</td>
</tr>
<tr>
<td>Tablet</td>
<td>Function</td>
<td>COMMAND</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>O 5</td>
<td>DIM TEXT</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>O 7</td>
<td>ZOOM ZF</td>
<td>AMZOOMVP</td>
</tr>
<tr>
<td>O 8</td>
<td>RTZOOM</td>
<td>RTZOOM</td>
</tr>
<tr>
<td>O 9</td>
<td>EXTENDS</td>
<td>ZOOM</td>
</tr>
<tr>
<td>O 10</td>
<td>ALL</td>
<td>ZOOM</td>
</tr>
<tr>
<td>O 11</td>
<td>ZOOM</td>
<td>ZOOM</td>
</tr>
<tr>
<td>P 4</td>
<td>CENTER LINE NARROW</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>P 5</td>
<td>CENTER LINE WIDE</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>P 7</td>
<td>3D ORBIT</td>
<td>3DORBIT</td>
</tr>
<tr>
<td>P 8</td>
<td>VMAX</td>
<td>ZOOM</td>
</tr>
<tr>
<td>P 9</td>
<td>0.5X</td>
<td>ZOOM</td>
</tr>
<tr>
<td>P 10</td>
<td>0.8X</td>
<td>ZOOM</td>
</tr>
<tr>
<td>P 11</td>
<td>PREVIOUS</td>
<td>ZOOM</td>
</tr>
<tr>
<td>Q 5</td>
<td>HATCH</td>
<td>AMLAYER</td>
</tr>
<tr>
<td>Q 7</td>
<td>DDUCS</td>
<td>UCSICON</td>
</tr>
<tr>
<td>Q 8</td>
<td>ICON</td>
<td>UCSICON</td>
</tr>
<tr>
<td>Q 9</td>
<td>OBJECT</td>
<td>UCSICON</td>
</tr>
<tr>
<td>Q 10</td>
<td>ORIGN</td>
<td>UCS</td>
</tr>
<tr>
<td>Q 11</td>
<td>UCS</td>
<td>UCS</td>
</tr>
<tr>
<td>R 7</td>
<td>VIEW ALL</td>
<td>AMVIEWALL</td>
</tr>
<tr>
<td>R 8</td>
<td>VIEW UPPER L</td>
<td>AMVIEWUL</td>
</tr>
<tr>
<td>R 9</td>
<td>VIEW UPPER R</td>
<td>AMVIEWUR</td>
</tr>
</tbody>
</table>
### Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>R 10</td>
<td>DDVIEW</td>
<td>VIEW</td>
</tr>
<tr>
<td>R 11</td>
<td>REGEN</td>
<td>REGEN</td>
</tr>
<tr>
<td>S 1</td>
<td>EXPLODE</td>
<td>EXPLODE</td>
</tr>
<tr>
<td>S 2</td>
<td>WBLOCK</td>
<td>WBLOCK</td>
</tr>
<tr>
<td>S 3</td>
<td>BLOCK</td>
<td>BLOCK</td>
</tr>
<tr>
<td>S 4</td>
<td>BLOCK EDIT</td>
<td>REFEDIT</td>
</tr>
<tr>
<td>S 5</td>
<td>INSERT</td>
<td>INSERT</td>
</tr>
<tr>
<td>S 7</td>
<td>VIEW CEN</td>
<td>AMVIEWCEN</td>
</tr>
<tr>
<td>S 8</td>
<td>VIEW LOWER L</td>
<td>AMVIEWLL</td>
</tr>
<tr>
<td>S 9</td>
<td>VIEW LOWER R</td>
<td>AMVIEWLR</td>
</tr>
<tr>
<td>S 10</td>
<td>PAN</td>
<td>PAN</td>
</tr>
<tr>
<td>R 11</td>
<td>REDRAW</td>
<td>REDRAWALL</td>
</tr>
<tr>
<td>T 1</td>
<td>IMAGE</td>
<td>IMAGE</td>
</tr>
<tr>
<td>T 5</td>
<td>LIBRARY</td>
<td>AMLIBRARY</td>
</tr>
<tr>
<td>U 1</td>
<td>XREF</td>
<td>XREF</td>
</tr>
<tr>
<td>U 2</td>
<td>XBIND</td>
<td>XBIND</td>
</tr>
<tr>
<td>U 4</td>
<td>XREF MAN</td>
<td>AMXREFSET</td>
</tr>
<tr>
<td>U 5</td>
<td>AUTO DETAIL</td>
<td>AMAUTODETAIL</td>
</tr>
<tr>
<td>U 7</td>
<td>AREA</td>
<td>AREA</td>
</tr>
<tr>
<td>U 8</td>
<td>CALC</td>
<td>CAL</td>
</tr>
<tr>
<td>U 9</td>
<td>ID</td>
<td>ID</td>
</tr>
<tr>
<td>U 10</td>
<td>DISTANCE</td>
<td>DIST</td>
</tr>
</tbody>
</table>
## Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>U 11</td>
<td>LIST</td>
<td>LIST</td>
</tr>
<tr>
<td>W 1</td>
<td>BREAK</td>
<td>AMDIMBREAK</td>
</tr>
<tr>
<td>W 2</td>
<td>JOIN DIM</td>
<td>AMDIMJOIN</td>
</tr>
<tr>
<td>W 3</td>
<td>STRETCH DIM</td>
<td>AMDIMSTRETCH</td>
</tr>
<tr>
<td>W 4</td>
<td>ADD LEAD</td>
<td>AMSYMLEADER_ADD</td>
</tr>
<tr>
<td>W 5</td>
<td>NOTE</td>
<td>AMNOTE</td>
</tr>
<tr>
<td>X 1</td>
<td>MULTI EDIT</td>
<td>AMDIMMEDIT</td>
</tr>
<tr>
<td>X 2</td>
<td>INSERT DIM</td>
<td>AMDIMINSERT</td>
</tr>
<tr>
<td>X 3</td>
<td>ARRANGE</td>
<td>AMDIMARRANGE</td>
</tr>
<tr>
<td>X 4</td>
<td>LIST</td>
<td>AMHOLECHART</td>
</tr>
<tr>
<td>X 5</td>
<td>AUTO DIM</td>
<td>AMAUTODIM</td>
</tr>
<tr>
<td>Y 1</td>
<td>MOVE</td>
<td>AIDIMTEXTMOVE</td>
</tr>
<tr>
<td>Y 2</td>
<td>ALIGN DIM</td>
<td>AMDIMALIGN</td>
</tr>
<tr>
<td>Y 3</td>
<td>D DIM</td>
<td>DDIM</td>
</tr>
<tr>
<td>Y 4</td>
<td>ANGLE</td>
<td>AMPoweredDIM_ANG</td>
</tr>
<tr>
<td>Y 5</td>
<td>FIT</td>
<td>AMFITSLIST</td>
</tr>
<tr>
<td>Z 1</td>
<td>x.</td>
<td>UNITS</td>
</tr>
<tr>
<td>Z 2</td>
<td>x.x</td>
<td>UNITS</td>
</tr>
<tr>
<td>Z 3</td>
<td>x.xx</td>
<td>UNITS</td>
</tr>
<tr>
<td>Z 4</td>
<td>x.xxx</td>
<td>UNITS</td>
</tr>
<tr>
<td>Z 5</td>
<td>x.xxxx</td>
<td>UNITS</td>
</tr>
</tbody>
</table>
## Tablet Area 2

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>A 13</td>
<td>PARTREF</td>
<td>AMPARTREF</td>
</tr>
<tr>
<td>A 14</td>
<td>EDIT PARTREF</td>
<td>AMPARTREFEDIT</td>
</tr>
<tr>
<td>A 15</td>
<td>ON/OFF</td>
<td>AMLAYPARTREFO</td>
</tr>
<tr>
<td>A 17</td>
<td>INTERNET</td>
<td>BROWSER</td>
</tr>
<tr>
<td>A 18</td>
<td>STOP</td>
<td>HYPERLINKSTOP</td>
</tr>
<tr>
<td>B 13</td>
<td>BALLOON</td>
<td>AMBALLOON</td>
</tr>
<tr>
<td>B 14</td>
<td>EDIT</td>
<td>AMEDIT</td>
</tr>
<tr>
<td>B 17</td>
<td>INSERT HYPERLINK</td>
<td>HYPERLINK</td>
</tr>
<tr>
<td>C 13</td>
<td>BOM DATABASE</td>
<td>AMBOM</td>
</tr>
<tr>
<td>C 14</td>
<td>PARTLIST</td>
<td>AMPARTLIST</td>
</tr>
<tr>
<td>C 17</td>
<td>ADCENTER</td>
<td>ADCENTER</td>
</tr>
<tr>
<td>C 18</td>
<td>DB CONNECT</td>
<td>DBCCONNECT</td>
</tr>
<tr>
<td>C 21</td>
<td>VIEWPORTS</td>
<td>VPORTS</td>
</tr>
<tr>
<td>C 23</td>
<td>PAPER/MODE</td>
<td>MSPACE / PSPACE</td>
</tr>
<tr>
<td>C 24</td>
<td>VPORT</td>
<td>AMVPORT</td>
</tr>
<tr>
<td>C 25</td>
<td>SCALE MONITOR</td>
<td>AMSCMONITOR</td>
</tr>
<tr>
<td>D 17</td>
<td>VARIO DATABASE</td>
<td>AMVARIODB</td>
</tr>
<tr>
<td>D 23</td>
<td>ON/OFF</td>
<td>AMLAYVPO</td>
</tr>
<tr>
<td>D 24</td>
<td>VP CREATE</td>
<td>AMVPORTAUTO</td>
</tr>
<tr>
<td>D 25</td>
<td>PLOT</td>
<td>PLOT</td>
</tr>
<tr>
<td>Tablet</td>
<td>Function</td>
<td>COMMAND</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>D 26</td>
<td>AUTO ZOOM</td>
<td>AMVPZOOMALL</td>
</tr>
<tr>
<td>F 13</td>
<td>2P</td>
<td>AMCONSTHB</td>
</tr>
<tr>
<td>F 14</td>
<td>CROSS</td>
<td>AMCONSTCRS</td>
</tr>
<tr>
<td>F 15</td>
<td>VERTICAL</td>
<td>AMCONSTVER</td>
</tr>
<tr>
<td>F 16</td>
<td>HORIZONTAL</td>
<td>AMCONSTHOR</td>
</tr>
<tr>
<td>F 17</td>
<td>DIALOG</td>
<td>AMCONSTLINES</td>
</tr>
<tr>
<td>F 18</td>
<td>PARALLEL</td>
<td>AMCONSTPAR</td>
</tr>
<tr>
<td>F 19</td>
<td>AUTO</td>
<td>AMAUTOCLINES</td>
</tr>
<tr>
<td>F 20</td>
<td>ERASE</td>
<td>AMERASECL</td>
</tr>
<tr>
<td>F 21</td>
<td>PROJECTION</td>
<td>AMPROJO</td>
</tr>
<tr>
<td>F 22</td>
<td>CONTOUR</td>
<td>AMTRCONT</td>
</tr>
<tr>
<td>F 24</td>
<td>DIMENSION</td>
<td>AMPowerDIM</td>
</tr>
<tr>
<td>F 25</td>
<td>DIMENSION</td>
<td>AMPowerDIM</td>
</tr>
<tr>
<td>F 26</td>
<td>DIMENSION</td>
<td>AMPowerDIM</td>
</tr>
<tr>
<td>G 13</td>
<td>CIRCLE</td>
<td>AMCONST_CIRCLE</td>
</tr>
<tr>
<td>G 14</td>
<td>XLINE/RAY</td>
<td>AMCONSTSWI</td>
</tr>
<tr>
<td>G 15</td>
<td>USER</td>
<td>AMUSERHATCH</td>
</tr>
<tr>
<td>G 16</td>
<td>2.3</td>
<td>AMHATCH_DBL</td>
</tr>
<tr>
<td>G 17</td>
<td>2.5</td>
<td>AMHATCH_45_2</td>
</tr>
<tr>
<td>G 18</td>
<td>5</td>
<td>AMHATCH_45_5</td>
</tr>
<tr>
<td>G 19</td>
<td>13</td>
<td>AMHATCH_45_13</td>
</tr>
<tr>
<td>G 20</td>
<td>2.7</td>
<td>AMHATCH_135_2</td>
</tr>
<tr>
<td>Tablet</td>
<td>Function</td>
<td>COMMAND</td>
</tr>
<tr>
<td>--------</td>
<td>---------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>G 21</td>
<td>4.7</td>
<td>AMHATCH_135_4</td>
</tr>
<tr>
<td>G 22</td>
<td>11</td>
<td>AMHATCH_135_11</td>
</tr>
<tr>
<td>G 24</td>
<td>ERASE</td>
<td>AMPOWERERASE</td>
</tr>
<tr>
<td>G 25</td>
<td>ERASE</td>
<td>AMPOWERERASE</td>
</tr>
<tr>
<td>G 26</td>
<td>ERASE</td>
<td>AMPOWERERASE</td>
</tr>
<tr>
<td>H 13</td>
<td>OUT CONT</td>
<td>AMCONTOUT</td>
</tr>
<tr>
<td>H 14</td>
<td>IN CONT</td>
<td>AMCONTIN</td>
</tr>
<tr>
<td>H 15</td>
<td>POINT</td>
<td>POINT</td>
</tr>
<tr>
<td>H 16</td>
<td>SPLINE</td>
<td>SPLINE</td>
</tr>
<tr>
<td>H 17</td>
<td>SKETCH</td>
<td>SKETCH</td>
</tr>
<tr>
<td>H 18</td>
<td>POLYGON</td>
<td>POLYGON</td>
</tr>
<tr>
<td>H 19</td>
<td>ELLIPSE</td>
<td>ELLIPSE</td>
</tr>
<tr>
<td>H 20</td>
<td>REGION</td>
<td>REGION</td>
</tr>
<tr>
<td>H 21</td>
<td>SOLID</td>
<td>SOLID</td>
</tr>
<tr>
<td>H 22</td>
<td>DONUT</td>
<td>DONUT</td>
</tr>
<tr>
<td>H 24</td>
<td>RECALL</td>
<td>AMPOWERRECALL</td>
</tr>
<tr>
<td>H 25</td>
<td>RECALL</td>
<td>AMPOWERRECALL</td>
</tr>
<tr>
<td>H 26</td>
<td>RECALL</td>
<td>AMPOWERRECALL</td>
</tr>
<tr>
<td>I 13</td>
<td>MLINE</td>
<td>MLINE</td>
</tr>
<tr>
<td>I 14</td>
<td>BREAK OUT</td>
<td>AMBROUTLINE</td>
</tr>
<tr>
<td>I 15</td>
<td>DETAIL</td>
<td>AMDetail</td>
</tr>
<tr>
<td>I 16</td>
<td>SECTION LINE</td>
<td>AMCUTPLNLINE</td>
</tr>
</tbody>
</table>
### Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>I 17</td>
<td>ZIG-ZAG</td>
<td>AMZIGZAGLINE</td>
</tr>
<tr>
<td>I 18</td>
<td>ARC</td>
<td>ARC</td>
</tr>
<tr>
<td>I 19</td>
<td>3P</td>
<td>CIRCLE _3P</td>
</tr>
<tr>
<td>I 20</td>
<td>2P</td>
<td>CIRCLE _2P</td>
</tr>
<tr>
<td>I 21</td>
<td>DIAMETER</td>
<td>CIRCLE _D</td>
</tr>
<tr>
<td>I 22</td>
<td>RADIUS</td>
<td>CIRCLE</td>
</tr>
<tr>
<td>I 24</td>
<td>COPY</td>
<td>AMPOWERCOPY</td>
</tr>
<tr>
<td>I 25</td>
<td>COPY</td>
<td>AMPOWERCOPY</td>
</tr>
<tr>
<td>I 26</td>
<td>COPY</td>
<td>AMPOWERCOPY</td>
</tr>
<tr>
<td>J 13</td>
<td>LINE</td>
<td>LINE</td>
</tr>
<tr>
<td>J 14</td>
<td>SYMLINE</td>
<td>AMSYMLINE</td>
</tr>
<tr>
<td>J 15</td>
<td>CENTERLINE</td>
<td>AMCENTLINE</td>
</tr>
<tr>
<td>J 16</td>
<td>CROSS</td>
<td>AMCENCROSS</td>
</tr>
<tr>
<td>J 17</td>
<td>CROSS+HOLE</td>
<td>AMCENCRCROSSHOLE</td>
</tr>
<tr>
<td>J 18</td>
<td>CORNER</td>
<td>AMCENCRCORNER</td>
</tr>
<tr>
<td>J 19</td>
<td>PLATE</td>
<td>AMCENCRCPLATE</td>
</tr>
<tr>
<td>J 20</td>
<td>FLANGE</td>
<td>AMCENCRCFULLCIRCLE</td>
</tr>
<tr>
<td>J 21</td>
<td>POLYLINE</td>
<td>POLYLINE</td>
</tr>
<tr>
<td>J 22</td>
<td>RECTANGLE</td>
<td>AMRECTANG</td>
</tr>
<tr>
<td>J 24</td>
<td>EDIT</td>
<td>AMPOWEREDIT</td>
</tr>
<tr>
<td>J 25</td>
<td>EDIT</td>
<td>AMPOWEREDIT</td>
</tr>
<tr>
<td>J 26</td>
<td>EDIT</td>
<td>AMPOWEREDIT</td>
</tr>
</tbody>
</table>
### Tablet Area 3

Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>V 19</td>
<td>MTEXT</td>
<td>MTEXT</td>
</tr>
<tr>
<td>V 21</td>
<td>TEXT</td>
<td>TEXT</td>
</tr>
<tr>
<td>V 23</td>
<td>FRAME</td>
<td>AMTITLE</td>
</tr>
<tr>
<td>V 24</td>
<td>ON/OFF</td>
<td>AMLAYTIBLO</td>
</tr>
<tr>
<td>V 25</td>
<td>SCALE</td>
<td>AMCHGTSC</td>
</tr>
<tr>
<td>V 26</td>
<td>PLOT DATE</td>
<td>AMPLOTDATE</td>
</tr>
<tr>
<td>W 19</td>
<td>LANGUAGE</td>
<td>AMLANGCONV</td>
</tr>
<tr>
<td>W 20</td>
<td>LANGTEXT</td>
<td>AMLANGTEXT</td>
</tr>
<tr>
<td>W 21</td>
<td>DDATTDEF</td>
<td>DDATTDEF</td>
</tr>
<tr>
<td>W 23</td>
<td>REV SW</td>
<td>AMREV</td>
</tr>
<tr>
<td>W 24</td>
<td>INSERT</td>
<td>AMREVLINE</td>
</tr>
<tr>
<td>W 25</td>
<td>UPDATE</td>
<td>AMREVUPDATE</td>
</tr>
<tr>
<td>X 19</td>
<td>TXT</td>
<td>AMTEXTTXT</td>
</tr>
<tr>
<td>X 20</td>
<td>SIMPLEX</td>
<td>AMTEXTSIMP</td>
</tr>
<tr>
<td>X 21</td>
<td>ITALIC</td>
<td>AMTEXTITAL</td>
</tr>
<tr>
<td>Y 19</td>
<td>7,0</td>
<td>AMTEXT7</td>
</tr>
<tr>
<td>Y 20</td>
<td>5,0</td>
<td>AMTEXT5</td>
</tr>
<tr>
<td>Y 21</td>
<td>3,5</td>
<td>AMTEXT3</td>
</tr>
<tr>
<td>Y 23</td>
<td>CONFIG</td>
<td>AMCONFIG</td>
</tr>
<tr>
<td>Y 24</td>
<td>SETUP DWG</td>
<td>AMSETUPDWG</td>
</tr>
</tbody>
</table>
**Tablet commands available in AutoCAD Mechanical 2000**

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y 26</td>
<td>OPTIONS</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>Z 19</td>
<td>RIGHT</td>
<td>AMTEXTRIGHT</td>
</tr>
<tr>
<td>Z 20</td>
<td>CENTER</td>
<td>AMTEXTCENTER</td>
</tr>
<tr>
<td>Z 21</td>
<td>FIT</td>
<td>AMTEXTFIT</td>
</tr>
<tr>
<td>Z 25</td>
<td>DDRMODES</td>
<td>DDRMODES</td>
</tr>
<tr>
<td>Z 26</td>
<td>SCRIPTGEN</td>
<td>AMSCRIPT</td>
</tr>
</tbody>
</table>

**Tablet Area 4**

**Tablet commands available in AutoCAD Mechanical 2000**

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>A 28</td>
<td>TARGET</td>
<td>AMDATUMTGT</td>
</tr>
<tr>
<td>A 30</td>
<td>CONNECTION</td>
<td>AMSCREWCON</td>
</tr>
<tr>
<td>A 31</td>
<td>MACRO</td>
<td>AMSCREWMACRO</td>
</tr>
<tr>
<td>A 32</td>
<td>COTTER PINS</td>
<td>AMCOTTERPIN</td>
</tr>
<tr>
<td>A 33</td>
<td>PLUG</td>
<td>AMPLUG</td>
</tr>
<tr>
<td>A 35</td>
<td>FEA</td>
<td>AMFEA2D</td>
</tr>
<tr>
<td>A 37</td>
<td>SHAFTGEN</td>
<td>AMSHAFT2D</td>
</tr>
<tr>
<td>B 28</td>
<td>WELD</td>
<td>AMWELDSYM</td>
</tr>
<tr>
<td>B 30</td>
<td>SCREW</td>
<td>AMSCREW</td>
</tr>
<tr>
<td>B 31</td>
<td>WASHER</td>
<td>AMWASHER</td>
</tr>
<tr>
<td>B 32</td>
<td>NUT</td>
<td>AMNUT</td>
</tr>
<tr>
<td>B 33</td>
<td>LUBRICATORS</td>
<td>AMLUBRI</td>
</tr>
</tbody>
</table>
# Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>B 35</td>
<td>SHAFT</td>
<td>AMSHAFTCALC</td>
</tr>
<tr>
<td>B 37</td>
<td>KEY</td>
<td>AMSHAFTKEY</td>
</tr>
<tr>
<td>C 28</td>
<td>WELD</td>
<td>AMSIMPLEWELD</td>
</tr>
<tr>
<td>C 30</td>
<td>GR.DR.STUD</td>
<td>AMNAILPIN</td>
</tr>
<tr>
<td>C 31</td>
<td>CONICAL PIN</td>
<td>AMCONICPIN</td>
</tr>
<tr>
<td>C 32</td>
<td>CYL. PIN</td>
<td>AMCYLPIN</td>
</tr>
<tr>
<td>C 33</td>
<td>SEALING RING</td>
<td>AMSEALRING</td>
</tr>
<tr>
<td>C 35</td>
<td>MOMENT</td>
<td>AMINERTIA</td>
</tr>
<tr>
<td>C 37</td>
<td>RET. RING</td>
<td>AMGROOVE</td>
</tr>
<tr>
<td>D 28</td>
<td>TOLERANCE</td>
<td>AMFCFRAME</td>
</tr>
<tr>
<td>D 30</td>
<td>OBLONG</td>
<td>AMOBLONGT</td>
</tr>
<tr>
<td>D 31</td>
<td>OBLONG BL</td>
<td>AMOBLONGB</td>
</tr>
<tr>
<td>D 32</td>
<td>PLAIN RIVET</td>
<td>AMPLRIVET</td>
</tr>
<tr>
<td>D 33</td>
<td>COUNT. RIVET</td>
<td>AMCRIVET</td>
</tr>
<tr>
<td>D 35</td>
<td>PREDEF</td>
<td>AMINERTIAPROF</td>
</tr>
<tr>
<td>D 37</td>
<td>CENTER</td>
<td>AMCENTERHOLE</td>
</tr>
<tr>
<td>E 28</td>
<td>DATUM</td>
<td>AMDATUMID</td>
</tr>
<tr>
<td>E 30</td>
<td>CLEVIS PIN</td>
<td>AMBOLT</td>
</tr>
<tr>
<td>E 31</td>
<td>STELL SHP.</td>
<td>AMSTLSHAP</td>
</tr>
<tr>
<td>E 32</td>
<td>BUSHING</td>
<td>AMDRBUSH</td>
</tr>
<tr>
<td>E 33</td>
<td>BUSHING + HOLE</td>
<td>AMDRBUSHHOLE</td>
</tr>
<tr>
<td>E 35</td>
<td>DEFLECTION</td>
<td>AMDEFLINE</td>
</tr>
</tbody>
</table>
### Tablet commands available in AutoCAD Mechanical 2000

<table>
<thead>
<tr>
<th>Tablet</th>
<th>Function</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>E 37</td>
<td>UNDER CUT</td>
<td>AMUNDERCUT</td>
</tr>
<tr>
<td>F 28</td>
<td>FEATURE</td>
<td>AMFEATID</td>
</tr>
<tr>
<td>F 30</td>
<td>SPRING</td>
<td>AMSPRING</td>
</tr>
<tr>
<td>F 31</td>
<td>SPROCKET</td>
<td>AMSPROCKET</td>
</tr>
<tr>
<td>F 32</td>
<td>CHAIN</td>
<td>AMCHAINDRAW</td>
</tr>
<tr>
<td>F 33</td>
<td>CHAIN/BELT</td>
<td>AMCHAINLENGTHCAL</td>
</tr>
<tr>
<td>F 35</td>
<td>BEARING</td>
<td>AMBEARCALC</td>
</tr>
<tr>
<td>F 37</td>
<td>BEARING</td>
<td>AMBEAR</td>
</tr>
<tr>
<td>G 28</td>
<td>SURFACE</td>
<td>AMSURFSYM</td>
</tr>
<tr>
<td>G 35</td>
<td>CAM</td>
<td>AMCAM</td>
</tr>
<tr>
<td>H 28</td>
<td>EDGE</td>
<td>AMEDGESYM</td>
</tr>
<tr>
<td>H 30</td>
<td>POWERVIEW</td>
<td>AMPowerview</td>
</tr>
<tr>
<td>H 31</td>
<td>DESCRIPT</td>
<td>AMNOTE</td>
</tr>
<tr>
<td>H 32</td>
<td>LIBRARY</td>
<td>AMSTDLIB</td>
</tr>
<tr>
<td>H 33</td>
<td>REPRESENT</td>
<td>AMSTDPREP</td>
</tr>
<tr>
<td>H 37</td>
<td>LOCKNUT</td>
<td>AMSHAFTLNUT</td>
</tr>
<tr>
<td>I 37</td>
<td>ADJ. RING</td>
<td>AMADJRINGS</td>
</tr>
<tr>
<td>J 28</td>
<td>THROUGH HOLE</td>
<td>AMTHOLE</td>
</tr>
<tr>
<td>J 29</td>
<td>INTERNAL THREAD</td>
<td>AMAMINTHREAD</td>
</tr>
<tr>
<td>J 30</td>
<td>EXTERNAL THREAD</td>
<td>AMEXTHREAD</td>
</tr>
<tr>
<td>J 31</td>
<td>BLIND HOLE</td>
<td>AMBHOLE</td>
</tr>
<tr>
<td>J 32</td>
<td>THREADED BLIND HOLE</td>
<td>AMTHRBHOLE</td>
</tr>
<tr>
<td>Tablet</td>
<td>Function</td>
<td>COMMAND</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>J 33</td>
<td>COUNTERBORE CYL.</td>
<td>AMCOUNTB</td>
</tr>
<tr>
<td>J 34</td>
<td>COUNTERSINK</td>
<td>AMCOUNTS</td>
</tr>
<tr>
<td>J 35</td>
<td>THREAD ENDS</td>
<td>AMTHREADEND</td>
</tr>
<tr>
<td>J 37</td>
<td>SHAFT END</td>
<td>AMSHAFTEND</td>
</tr>
</tbody>
</table>
2D hide  A closed contour (with islands) that can be used to define an area. This area is used to change the representation of other objects. Usually, these objects are lying behind this area (in the 3D sense) and are partly or entirely invisible in the view.

acceleration  Graph of acceleration of the straight driven element of the rotation angle acceleration of a rocker and the cam plate angle of rotation.

ACIS  An open-architecture, object-oriented program, that provides a geometric engine for application developers. ACIS supports methods for creating and editing a broad range of 3D geometric objects including splines, surfaces, and solids. (ACIS stands for Alan, Charles, Ian Systems.)

action pane  The area in the Dimension Formatter dialog box where your change to a control is dynamically reflected on your drawing.

annotation  An object, such as text or geometry, that is attached to a drawing to describe a design. Examples are surface finish symbols, callout balloons, and BOMs (bills of materials).

attach  The act of connecting a reference file to the current assembly file. The attachment remains with the current file after the file is saved.

auto detailing  A function where component detail drawing can automatically be inserted in the drawing under a specific scale, with a border and a title block. Layer groups or selected elements can be set as components for the auto detailing.

automatic dimension  A function that offers various options to dimension a 2D contour automatically. You determine the point marking the origin of the
dimension. The function searches for the edges of the work piece and
dimensions according to the selected dimension type.

**background** A contour that is covered by another contour or by objects
that are lying behind another contour, in the 3D sense. A background may be a
foreground for an additional contour.

**balloon** Circular annotation tag that identifies a bill of material item in a
drawing. The number in the balloon corresponds with the number of the part
in the bill of material.

**base dimension** The first dimension selected for joining, inserting, and
aligning dimensions.

**base layer** A layer made up of working layers and standard parts layers.
Base layers are repeated in every layer group.

**base standard** Predefined drafting standard that conforms to International
Drafting Standards: ANSI, ISO, DIN, BSI, GB, CSN, and JIS.

**baseline dimensioning** A dimension that is aligned to extension lines and
read from the bottom or right side of the drawing.

**bearing calculation** Calculates limiting value, dynamic and static load
rating, dynamic and static equivalent load, and fatigue life in revolutions and
hours.

**Belleville spring washer** A washer-type spring that can sustain relatively large
loads with small deflections. The loads and deflections can be increased by
stacking the springs.

**bill of material** A dynamic database containing a list of all the parts in an
assembly. Used to generate parts lists that contain associated attributes such as
part number, manufacturer, and quantity.

**BOM attribute** An entity that contains attributes by default (the attribute is
invisible) that can add information to and describe details of a part in the
drawing. The values of these attributes are transformed into the parts list
attributes when converting BOM attributes and creating a parts list.

**breakout line** Shows a partial area of a broken view.

**cam** Types of gears for obtaining unusual and irregular motions that
would be difficult to produce otherwise.

**centerline** Line in the center of a symmetrical object. When you create
centerlines, you specify the start and end points.

**chain dimensioning** A dimensioning that always refers to the end of the
last dimension.

**chamfer** A beveled surface between two faces or surfaces.
clearance  A mating where the parts fit together loosely.

**C-line (construction line)**  A line that is infinite in both directions or infinite starting at a point which can be inserted into the drawing area. You use C-lines to transfer important points (for example, center points of bore holes) into other views or drawing areas.

collinear  The relative position of any number of lines or linear edges that have the same slope and are coincident with one another.

**compression spring**  A spring type that can be compressed and can absorb pressure forces.

**concentric**  The relative position of any number of arcs or circles that shares the same center point or projected center point.

**cone**  A solid object with a round base and a point at the top.

**construction geometry**  Any line or arc created with construction lines. Using construction geometry in 2D drawings helps you to define your contour shape.

**contour inside**  Displays the inner contour of an object. You need to select the boundary edges on underlying layers (0, AM_0, AM_1, AM_2).

**contour .outside**  Displays the outer contour of an object. You need to select the boundary edges on underlying layers (0, AM_0, AM_1, AM_2).

**contour trace**  A function that can combine a number of entities to form a closed polyline consisting of individual segments. This polyline can be copied and processed, ( to calculate the dimensions for example).

**counterbore**  A blind hole of a larger diameter that is drilled concentric with a hole to allow bolt and screw heads to be flush or below the part surface.

**countersink**  A chamfered hole that allows bolt and screw heads to be flush or below the part surface.

**cross section**  Manually created 2D view which shows a cut through a part.

**curve path**  Geometric shape of the cam.

**cut line**  Used to specify the path of a cross-section drawing view.

**cutting plane line**  Imaginary cutting line through a work piece. The arrows determine the cutting direction. Also called section line.

**cylinder axial**  Option for inserting a standard part or hole parallel to a cylinder axis.

**cylinder radial**  Option for inserting a standard part or hole radial into a cylinder.
datum identifier  A symbol consisting of a frame with a reference letter.

datum target  Used to establish a theoretical exact plane, line, or profile. All features are subject to deviation, and it may be impractical to control the tolerance of an entire surface via a datum. In order to specify practical data, relevant locations called datum targets are selected and indicated on a drawing. The datum target may be a point, a line, or an area.

deflection line  Deflection line calculations are based on the predefined force direction (F) or the radial direction (r).

deflection moment  Deflection moment calculations are based on the predefined force direction (F) or the radial direction (r).
detach  Permanently removing a file as an external reference from an assembly.
detail  A portion of the design drawing that cannot be clearly displayed or dimensioned. The overall representation (surface texture symbols) can be enlarged.
digitizing  A manual or automatic process utilizing a mechanical device to follow and electronically record the 2D shape of a line in a drawing.
dimensional tolerance  The width of the tolerance (upper deviation - lower deviation).
distance snap  Makes the dimensions in the drawing appear uniform. A dimension line is automatically inserted at a defined distance from the object being dimensioned. The line remains "fixed" and is highlighted in red color as soon as the required distance to the object being dimensioned is reached.
distributed force  A force that is spread over an area.
drawing  A layout of drawing views in model space or layout.
drawing border  A standardized frame, that is used for technical drawings.
drawing mode  Establishes the settings for paper space so that you can create a drawing of your model. When Drawing mode is off, you are in model space.
drawing title  The drawing title is drawn in the lower right corner of the drawing and provides information about your drawing. Some title attributes are pre-assigned. You can modify or add attributes.
drawing view  A defined, oriented view of a part or model used for manufacturing.
drilled  A single-diameter hole with no counterbore or countersink.
dynamic calculation  Calculation required for a revolving bearing. The result is the Adjusted Rating Life. This is the life associated with 90% reliability with contemporary, commonly used material, and under conventional
operating conditions. With the number of revolutions you get the life in working hours.

dynamic dragging  The act of determining the size of a standard part with the cursor while inserting the part into a side view. The standard part is displayed dynamically on the screen and can be dragged to the next possible size and length. The values (sizes) are taken from the Standard parts database.

dynamic dragging  The act of determining the size of a standard part with the cursor while inserting the part into a side view. The standard part is displayed dynamically on the screen and can be dragged to the next possible size and length. The values (sizes) are taken from the Standard parts database.

dynamic dragging  The act of determining the size of a standard part with the cursor while inserting the part into a side view. The standard part is displayed dynamically on the screen and can be dragged to the next possible size and length. The values (sizes) are taken from the Standard parts database.

dynamic dragging  The act of determining the size of a standard part with the cursor while inserting the part into a side view. The standard part is displayed dynamically on the screen and can be dragged to the next possible size and length. The values (sizes) are taken from the Standard parts database.

edge symbol  Symbol used to describe edges of objects, which are generated using certain production processes. The object edge consists of the basic symbol, the edge dimension, and the symbol element + or -. You can also specify an upper and lower limit for the edge dimension.

element  A geometric object bounding a face on a part.

element filter  Filters entities on a defined layer.

extension spring  A spring type that can absorb tension forces.

external drawing  A drawing reference that resides in a file other than the current assembly file.

family of lines  A term referring to a set of polylines or splines that share common characteristics, for example, lines that are parallel to each other.

FEA  Finite Element Analysis. A calculation routine, or method. Calculates stress and deformation in a plane for plates with a given thickness, or in a cross section with individual forces, stretching loads, and fixed and/or movable supports. The FEA routine uses its own layer group for input and output.

feature control frame symbol  Symbol that gives an accurate and concise meaning to specifying geometric characteristics and tolerances. Notes can supplement symbols where appropriate.

feature identifier symbol  Specifies individual features for tolerancing.

fillet  A curved transition from one part face or surface to another. The transition cuts off the outside edge or fills in the inside edge.

fit  Range of tightness or looseness in mating parts (for example shafts or holes). Tolerances in these dimensions are expressed in standard form.

fit name  Name of the selected fit (for example H7).

fit type  There are three kinds of fit types: Interference, Clearance, and Transition.

fits list  A table of all fits within a drawing. The fits list function searches the entire drawing for fits. Once they have been gathered, you are asked where to insert this list for in your drawing.

fixed support  A support that is fixed to a part and cannot be moved.
foreground  Objects which are lying in front of another contour in the 3D sense. A foreground may also be a background for an additional contour.

gear  Any several arrangements, especially of toothed wheels in a machine which allows power to be passed from one part to another so as to control the power speed or the direction of movement.

gear  Any several arrangements, especially of toothed wheels in a machine which allows power to be passed from one part to another so as to control the power speed or the direction of movement.

geometric tolerance  The general term applied to the category of tolerances used to control form, profile, orientation, location, and run out.

groove  A long narrow path made in a surface (for example in a shaft).

hidden line  Line that is not visible in a specified view. For example, in a front view, lines behind the front plane would not be visible.

hole  A geometric feature with a predefined shape: drilled, counterbore, or countersink.

hole chart  A table with X and Y coordinates, and the radius of holes in a plate.

instance  A single occurrence of a block definition placed into a physical assembly. A single block definition can be represented with multiple instances.

interference  A mating where the parts always grip tightly.

language converter  Tool that dynamically translate texts, attribute values, Mtexts (multiline texts), and default values of attributes in selected blocks into other languages.

layer group  A group of associated or related items in a drawing. A major advantage of working with layer groups is that you can deactivate a specific layer group and a complete component. The drawing and its overview are enhanced by reduction in regeneration time.

layout  The tabbed environment in which you create and design paper space floating viewports to be plotted. Multiple layouts can be created for each drawing.

leader line  Command, for adding leader lines to existing leader lines.

library  A feature for storing parts (blocks, drawings) in a library.

load  The forces and moments that act on a part.

lower deviation  A negative (or the lowest) deviation from the nominal size.

lower tolerance  A negative tolerance.

lubricator  A device for lubricating parts.
**mass properties**  Volumetric information on a part or model that is based on the density of the material. Mass properties include the center of gravity, principle axes, moments of inertia, and mass.

**mating**  Two combined fits: one "shaft" and one "hole".

**maximum clearance**  The maximum mating where the parts will fit together loosely.

**maximum limit of size**  Nominal size of a part plus the upper deviation. The part does not exceed this size.

**minimum clearance**  The minimum mating where the parts will fit together loosely.

**minimum limit of size**  Nominal size of a part plus the lower deviation. The part remains above this size.

**moment of inertia**  An important property of areas and solid bodies. Standard formulas are derived by multiplying elementary particles of area and mass by the squares of their distances from reference axes. Moments of inertia, therefore, depend on the location of reference axes.

**moveable support**  A support that is not fixed.

**movement diagram**  The representation of the cam as a graph of the lift and the angle of rotation of the cam plate (straight driven element). If the driven element is a rocker, the lift corresponds to an angle of rotation of the rocker.

**movement section**  Part of the movement diagram. Some sections are defined by design. For example, the maximum lift of 15 mm is reached at an angle of 90°.

**NC**  Numerical Control. Used in the manufacturing industry to represent the control on machine tool movement through numeric data for 2 to 5 axis machining.

**nominal size**  The ideal dimensional value.

**object prototypes**  Properties of layers and objects.

**ordinate dimensioning**  In general, this ordinate dimensioning practices are compatible with the data requirements for tape or computer-controlled automatic production machines.

**parallel guides**  Support that has a degree of freedom in the vertical direction.

**parent view**  A drawing view on which other views are based. For example, the base view is the parent view for an isometric or orthographic view.
**partition** Distance in mm or inches between centers of adjacent joint members. Other dimensions are proportional to the pitch. Also known as pitch.

**part layer** A layer where the standard parts are put. All standard parts layers have the suffix AM_*N.

**part reference** Part information for a bill of material, which is attached to the part in the drawing.

**parts list** A dynamic list of parts and associated attributes generated from a bill of material database. The parts list automatically reflects additions and subtractions of parts from an assembly.

**pitch** The measured distance parallel to the axis of a thread, from one point on the path to the corresponding point on the adjacent revolution.

**pitch diameter** The diameter of the pitch circle that passes through the centers of the link pins as the chain is wrapped on the sprocket.

**point force** A force that is concentrated on a point.

**power command** Summary term for Power Copy, Power Recall, Power Edit, Power Dimensioning, Power Erase, and Power View.

**Power Copy** A command that copies a drawing object to another position in the drawing. Power Copy produces an identical copy of the copied object.

**Power Dimensioning** A command useful for generating linear, radial, and diameter dimensions while minimizing the number of the individual actions for generating a dimension. Power Dimensioning automatically selects the type of the linear dimension (horizontal, vertical, aligned), based on the selected point.

**Power Edit** A single edit command for all objects in your drawing.

**Power Erase** Command for deleting. Use Power Erase when you delete part reference numbers or dimensions that were created with Power Dimensioning.

**power object** An object or a group of drawing objects that contain additional information.

**Power Recall** A command that lets you click an existing drawing object and places you in the correct command for creating that object.

**Power View** A tool where you can quickly and easily create a standard part top view from a side view.

**preselection** Option that allows you to set preferences for parts based on your company's standards. For example only cylinder head screws greater than M8 are used in your company. In this case, you delete the company preference for cylinder head screws smaller than M8.
radius reflection line  Thin line that represents the radius in the side or top view.

representation  Standard parts representation in a drawing in normal, simplified, and symbolic mode.

resolution (cam plate)  Controls the precision of curves. A low value increases computing time. Use a higher value for initial design.

revision list  A line block to be inserted in the drawing after each change in the drawing. The list can contain the date of change, the name of the person responsible for the changes, and a description of the changes.

roller chain  A roller chain is made up of two kinds of links: roller links and pin links alternately and evenly spaced throughout the length of the chain.

scale area  Displays a particular scale area (corresponds to zoom viewport). The respective scales can be viewed before zooming.

scale monitor  A function where you can control the scale for each viewport.

screw template  Enables you to include frequently used screw connections which were saved before.

script generator  Feature that enables you to work on a select set of drawings. In the script, you can combine as many LISP routines as required.

script  Scripts contain a set of AutoCAD commands which are executed sequentially with a single SCRIPT command. Script files are saved in a text format and stored in an external file with the extension SCR.

section line  Line through a 2D view which defines the cross section.

shaft break  Interruption of a shaft. A shaft can be interrupted at a point, and the shaft break symbols are inserted in a suitable size.

shaft generator  Tool to draw rotationally symmetric parts. A shaft is usually created from left to right using different sections. These sections are positioned automatically one after the other. Additionally, any shaft section can be inserted, deleted, or edited.

simple weld  Draws arc and V welds in plain views and cross-sections. Ellipses, circles, arcs, lines and polylines can be provided with a weld.

slope  A measure of an angle from a level direction.

sprocket  A toothed wheel that transfers the power from the chain to the shaft or the other way round.

static calculation  Required for bearing-suffering loads in standstill or swinging movement, or for small numbers of revolutions (n < 20 1/min).
**step width**  
Specifies the distance between the points used for the NC records.

**stress**  
Force or pressure on a part. Stress is the force per area.

**surface texture list**  
A summary list of all surface texture symbols in a drawing.

**surface texture symbol**  
Symbol that specifies surface texture finish. The symbols conform, in terms of their geometry and annotations (which includes text and other symbols), to international drafting standards.

**symmetrical deviation**  
Tolerance values that have equal maximum and minimum values.

**symmetrical line**  
Segments, that are symmetrical to the line segments drawn and automatically mirrored at a centerline.

**tangent**  
A condition where two items share the same slope at a specified point.

**taper angle**  
The angle where a thread is tapered as it is created.

**template**  
A file with predefined settings to use for new drawings; however, any drawing can be used as a template.

**title block**  
A title block contains a series of attributes; some already have values. The pre-assigned values can be modified, and the vacant attributes can be completed with new values.

**tolerance**  
The total amount by which a given dimension (nominal size) may vary (for example, 20 ± 0.1).

**torsion spring**  
A spring type that can absorb torque forces.

**transition**  
A mating in between a true Clearance or Interference.

**UCS**  
User coordinate system. Designated by arrows that signify the XY coordinates. Establishes a construction plane and simplifies location of 3D points. Provides visual reference for positioning a surface.

**upper deviation**  
The positive (or highest) deviation from the nominal size.

**variation of fit**  
In a mating, the difference between the tightest possible and loosest possible fit combinations.

**vario database**  
Database that manages all parametric templates. The database is essential for activating and storing templates.

**velocity (cam plate)**  
Graph of the speed of the straight driven element, or the rotation angle of a rocker and the cam plate angle of rotation.
**view scale**  The scale of a base drawing relative to the model scale. Also, the scale of dependent views relative to the base view.

**viewport**  In Drawing mode, a bounded area that displays a drawing view.

**virtual intersection**  Two lines have a virtual intersection if they are not parallel. The virtual intersection is the intersection of the line extensions.

**welding symbol**  Specifies information for welding.

**welding**  Welding of metals requires that they be heated to a molten state so that they fuse together.

**working layer**  The layer where you are currently working.

**wrench opening**  In the shaft generator, sectional views for two-sided, four-sided, six-sided segments of shafts that fit a standard wrench.